
$10 

	 Check for Updates
	 Make sure you have the latest information!

	 Help 	 Catalog 	 Feedback	 Blog 	 Order Print Copy 	

TidBITS Publishing Inc.

Take Control of

Paperless 
OfficeJoe Kissell

	 v1.0

Your

http://www.takecontrolbooks.com/checkforupdates?mw=offiziersfisch&bt=0113&bv=1.0
http://www.takecontrolbooks.com/faq
http://www.takecontrolbooks.com/checkforupdates?mw=offiziersfisch&bt=0113&bv=1.0&pr=1
http://www.takecontrolbooks.com/checkforupdates?mw=offiziersfisch&bt=0113&bv=1.0&bl=1
http://www.takecontrolbooks.com/checkforupdates?mw=offiziersfisch&bt=0113&bv=1.0&fb=1
http://www.takecontrolbooks.com/catalog?pt=INTERNAL
http://www.takecontrolbooks.com/


2 

Table of Contents 
 

 

Read Me First  4	
  
Updates and More..................................................................... 4	
  
Basics ..................................................................................... 5	
  

Introduction  7	
  
Paperless Office Quick Start  9	
  
Meet Your New Paperless Office  11	
  

Learn the Benefits of Ditching Paper...........................................11	
  
Understand Searchable PDFs.....................................................13	
  
Consider Storage Options .........................................................15	
  
Envision a Paperless Future.......................................................20	
  

Head Off Most Paper before It Reaches You  23	
  
Sign Up for Paperless Billing......................................................23	
  
Choose Online Bank Statements ................................................25	
  
Receive Invoices Electronically ..................................................26	
  
Explore Other Paperless Options ................................................26	
  
Get Paperless Postal Mail ..........................................................27	
  

Choose a Document Scanner  30	
  
Learn Why Document Scanners Are Different...............................30	
  
Consider Important Scanner Features.........................................32	
  
Pick a Mac-Compatible Scanner .................................................35	
  
Joe’s Scanner Recommendations ...............................................40	
  

Choose OCR Software  42	
  
Determine Your Needs..............................................................42	
  
Consider Important OCR Features ..............................................43	
  
Pick a Mac OCR Package ...........................................................46	
  
Joe’s OCR Software Recommendations .......................................51	
  

Configure Your Software  53	
  
Understand the Scanning Process ..............................................53	
  
Set the Resolution ...................................................................55	
  
Set the Destination ..................................................................58	
  
Set the File Format ..................................................................61	
  
Set Other Scanning Options ......................................................62	
  
Set OCR Options......................................................................63	
  
Choose a Naming and Filing Strategy .........................................65	
  
Automate OCR ........................................................................73	
  

D
ow

n
lo

a
d
 f
ro

m
 W

o
w

! 
e
B
o
o
k 

<
w

w
w

.w
o
w

e
b
o
o
k.

co
m

>
D
ow

n
lo

a
d
 f
ro

m
 W

o
w

! 
e
B
o
o
k 

<
w

w
w

.w
o
w

e
b
o
o
k.

co
m

>



3 

Create a Workflow for Incoming Paper  80	
  
Create a Physical Paper Path .....................................................80	
  
Scan All Incoming Paper Immediately.........................................84	
  
Back Up Scanned Data .............................................................85	
  
Keep Legally Important Documents............................................85	
  
Recycle or Shred Leftovers........................................................86	
  

Work Through a Backlog  87	
  
Prune Unnecessary Documents..................................................87	
  
Prioritize What’s Left ................................................................88	
  
Try Scanning 50 Sheets Per Day ................................................89	
  
Hire a Minion...........................................................................89	
  
Outsource Scanning .................................................................89	
  

OCR on the Go  91	
  
Learn about Pocket-sized OCR Tools...........................................91	
  
Pick an iOS OCR App................................................................92	
  
Use Other Smartphones............................................................93	
  
Use Your Digital Camera ...........................................................95	
  

Avoid Common Printing Needs  96	
  
Think (and Track) When You Print..............................................96	
  
Review and Annotate Documents ...............................................97	
  
Take Notes without Paper .........................................................98	
  
Send Invoices Electronically ......................................................98	
  
Fax (Paperlessly) When Email Isn’t an Option ..............................99	
  
Always Print to PDF When Possible .............................................99	
  
Never Print “Just in case”........................................................ 100	
  
Carry a Mobile Device Instead of Paper..................................... 101	
  

Sign Documents without Paper  103	
  
Determine When a Pseudo-Signature Is Acceptable .................... 103	
  
Scan Your Signature .............................................................. 104	
  
Superimpose Your Signature on a PDF...................................... 105	
  
Learn about Digital Signatures................................................. 107	
  

Fax without Paper  110	
  
Receive Incoming Faxes ......................................................... 110	
  
Send Outgoing Faxes ............................................................. 113	
  

About This Book  115	
  
Copyright and Fine Print  117	
  
Featured Titles  118	
  
 



4 

Read Me First 
 
Welcome to Take Control of Your Paperless Office, version 1.0, 
published in November 2010 by TidBITS Publishing Inc. This book 
was written by Joe Kissell and edited by Tonya Engst. 

This book guides you in the process of eliminating paper clutter, 
replacing many printed documents with digital versions—with 
special emphasis on the Mac-compatible hardware, software, and 
process needed to efficiently scan documents and create searchable 
PDFs. It also helps you find clever ways to reduce both incoming 
and outgoing office paper, and capture documents even when no 
scanner is available. 

Copyright © 2010, Joe Kissell. All rights reserved. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to buy 
a new copy to read it more carefully or to keep it for reference. 

Discounted classroom and Mac user group copies are also available. 

Updates and More 
You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to pur-
chasers). On the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB 
and Mobipocket. (Learn about reading this ebook on handheld 
devices at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top 
of the blog, you can also see any update plans for the ebook. 

http://www.takecontrolbooks.com/class-copies
http://www.takecontrolbooks.com/device-advice
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Basics 
Here are a few “rules of the road” that will help you read this book: 

• Menus: Where I describe choosing a command from a menu in 
the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 
folder in the Finder is “File > New Folder.” 

• Contextual menus: Contextual menus appear when you Control-
click various elements on a Macintosh screen, including Dock items 
and files in Finder windows. To describe opening a contextual 
menu, I tell you to right-click (Control-click) an item on the screen. 
Control-clicking always works, but if your mouse offers a right-click 
option, or if you use a trackpad or other means of opening a con-
textual menu, you should feel free to use the method you prefer. 

• Finding System Preferences: I sometimes refer to settings in 
System Preferences that you may want to adjust. To open System 
Preferences, click its icon in the Dock or choose Apple () > System 
Preferences. When the System Preferences window opens, click the 
icon of the pane whose settings you want to adjust. I refer to these 
panes using a brief notation such as “the Dock preference pane.” 

• Finding an application’s preferences: I often refer to pref-
erences in an application that you may want to adjust. Don’t confuse 
an application’s preferences with the system-wide settings found in 
System Preferences. To access an application’s preferences, choose 
Application Name > Preferences. For example, in Microsoft Word, 
you would choose Microsoft Word > Preferences. 

• Path syntax: This book occasionally uses a path to show the 
location of a file or folder in your file system. For example, Mac 
OS X stores most utilities, such as Terminal, in the Utilities folder. 
The path to Terminal is: /Applications/Utilities/Terminal. 

The slash at the start of the path tells you to begin at the top level of 
the disk. Some paths begin with ~ (tilde), which is a shortcut for the 
current user’s home directory. For example, if the person currently 
logged in has the user name joe and wants to install fonts that only 
he can access, he would put them in ~/Library/Fonts, which is just 
another way of writing /Users/joe/Library/Fonts. 
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• Desktop vs. mobile: For the purpose of this book, a desktop 
computer is either a laptop (most of which sit on desks) or a 
conventional computer running an operating system such as Mac 
OS X or Windows. A mobile device is a handheld computer-like 
device, such as an iPhone, iPad, Kindle, or BlackBerry. 

A mobile device uses a mobile operating system, such as iPhone 
OS 3 or iOS 4. Mobile software is designed for mobile devices. For 
example, the version of Safari that runs on the iPad is the mobile 
version of Apple’s desktop Safari Web browser, and it is more tech-
nically called Mobile Safari. I try to avoid these terms in this book 
because they can be confusing for beginning readers, but you will 
find them in other writing and even in other Take Control ebooks. 
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Introduction 
 

 
My feelings about paper might best be described as ambivalent. As 
I write these words, I’m sitting in a library surrounded by books of the 
old-fashioned paper kind. I’ve written several such books myself, and 
I’ve often formed opinions about people based on how many books 
(and which ones) are in their homes. Had paper never been invented, 
I imagine many other aspects of modern life as we know it would never 
have developed. Paper facilitated the recording of history, the dissemi-
nation of knowledge, the spread of literacy, and a great many other 
virtuous things that I’m grateful for. 

On the other hand, I’ve also written a couple dozen ebooks like the 
one you’re now reading, and have shifted most of my professional 
and recreational reading to books in digital formats—an activity made 
considerably more enjoyable by my iPad and iPhone 4 (especially with 
the latter’s Retina display). I like the fact that I can search, annotate, 
and back up my books now, and that I can accumulate as many as I 
want without running out of shelf space, as is a regular occurrence 
in my home. 

But I truly lose all tolerance for paper when it comes to office 
paperwork—letters, forms, invoices, bank statements, receipts, 
business cards, flyers, note cards, catalogs, handouts from meetings 
and trade shows, photocopies of library book pages, and anything else 
that might end up on my desk in printed form. I used to have several 
filing cabinets full of the stuff, and overflowing—and yet, despite what 
I thought was an intelligent filing system, it frequently took me a long 
time to find what I was looking for. And because every day more of it 
would appear (some of it coming from my own printer), it was difficult 
to keep on top of it. The clutter became unmanageable, and I found 
that I spent far too much of my time managing paper rather than 
accomplishing useful tasks. 

Never is the scourge of paper clutter more apparent than when I move, 
which I tend to do every few years or so. I get tired just looking at all 
those paper files, and I find myself cursing all those paper books that 
I love to surround myself with, because they’re so heavy and bulky.  
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But most of my struggle with paper, I’m happy to say, is in the past. 
For a few years now I’ve been moving toward a paperless office. I now 
receive, and generate, only a tiny fraction of the paper I once did. And 
virtually every paper document that comes into my life is scanned, 
converted to a searchable format, and digitally archived—so I can 
find nearly any document I need with a few keystrokes. And, because 
everything is backed up, I don’t worry about my papers being wiped 
out by a fire or other catastrophe. 

In this ebook, I explain how you can do what I do when it comes 
to paper. By carefully examining where and how you use paper and 
looking for suitable digital alternatives, you’ll find that your produc-
tivity and happiness increase, while clutter and stress decrease. You 
might even save some money and benefit the environment. 

What I describe here is a multi-pronged approach to strategically 
eliminating paper. Of course, even if you avoid generating your own 
paper clutter and reduce the paper other people send you, some paper 
will still find its way to you—and you may have many thousands of 
pages already sitting around. So one of the central features of the plan 
I discuss is scanning your paper documents and processing them in a 
way that retains their physical appearance while also letting you index, 
search, select, and copy their text. I also talk about using devices such 
as the iPad, iPhone, and Kindle (as well as smartphones and digital 
cameras) to maximum advantage—and doing clever things you may 
never have thought of, like paperless postal mail and fax. 

Let me be clear, though: I’m not going to tell you to get rid of all your 
paper, or that resorting to paper for any reason is somehow a moral 
failure. Paper has many noble uses, and I wouldn’t pretend otherwise. 
You may choose to adopt all my recommendations, or only a few—
everyone’s different, so by all means, do only what works for you. 

The plan I cover in this book is appropriate for a home office or small 
business. If you aspire to take a large corporation paperless, I applaud 
you—but that sort of project is beyond the scope of this ebook. 

Finally, I assume that you have at least one Mac at your disposal. 
While everything I discuss can be accomplished in a comparable 
fashion with other operating systems, in this ebook I focus on Mac-
compatible hardware and software. 
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Paperless Office 
Quick Start 
 
This book shows you how to reduce the use of paper in your home 
or office and use digital representations of documents instead (or in 
addition). You can learn about these topics in any order, but most of 
the chapters follow a logical progression, so I encourage you to read 
linearly. In any case, I urge you to start with Meet Your New 
Paperless Office, which provides useful background information. 

 

Take preliminary steps: 
• Learn about the goal and the steps you’ll take to reach it; see Meet 

Your New Paperless Office. 

• Give yourself some breathing room: Head Off Most Paper Before It 
Reaches You. 

Digitize and dispose of most incoming paper: 
• Decide on the most important tool for creating a paperless office; 

read Choose a Document Scanner. 

• Learn what features you need in Mac software to accompany your 
scanner in Choose OCR Software. 

• Set up your software for optimal efficiency and quality; see 
Configure Your Software. 

• Figure out the most convenient way to process papers you receive in 
Create a Workflow for Incoming Paper. 

• Devise a plan to scan all those paper documents already in your 
files; read Work Through a Backlog. 

• Capture digital copies of documents even when you’re away from 
your scanner; see OCR on the Go. 

Reduce the amount of paper you generate yourself: 
• Learn how to break the printing habit painlessly (at least some-

times) in Avoid Common Printing Needs. 
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• Discover when a signature is not a signature; see Sign Documents 
without Paper. 

• Say goodbye to your fax machine and hello to another 300 square 
inches of desk space; see Fax without Paper. 
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Meet Your New 
Paperless Office 
 
The idea of a paperless office may sound enticing, or even inspiring. 
It may also sound intimidating. If you’re going to make the transi-
tion to a paperless lifestyle, what will you have to give up—and what 
will you get in return? In this chapter I look at the advantages of a 
paperless office (ranging from obvious to novel), and then describe 
some of its crucial components. I also help you imagine what your 
paperless office will ultimately look like. 

Learn the Benefits of Ditching Paper 
If you’re reading this ebook, chances are you already have a paper-
related problem you’re trying to solve. You know the ways in which 
paper is causing you pain, so it’s apparent how a paperless office would 
be soothing. But, in fact, a paperless office can solve many problems 
simultaneously—including some you didn’t even realize you had! 

Let’s look at some of the things you can accomplish by moving from 
paper to digital: 

• Reduce clutter. Clutter reduction is a recurring theme in this 
ebook. “Clutter” may refer to the untidy piles of papers that litter 
your desk and haphazard filing systems, but even a scrupulously 
organized collection of paper documents counts as clutter if it takes 
up too much physical space—or too much of your attention—for 
comfort. Scaling back on paper brings order back into your office, 
and also frees up space on your desk and in your brain. 

• Save time and effort. Filing a single document may take just 
seconds, but the endless process of filing, searching for, retrieving, 
and replacing papers can add up to hours per week. You’ll still file 
digital documents, but searching will take far less time and be less 
error-prone—plus there’s nothing to put back when you’re done. 
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• Save money. In a paperless office, you save a little bit of money 
on paper (hey, it’s not that expensive in the first place), but when 
you add up the savings in printers, photocopiers, ink or toner car-
tridges, envelopes, file folders, filing cabinets, extra office space to 
hold all the filing cabinets, and so on, the amount becomes more 
interesting. Even better, you’re saving time (the previous point), 
and since time is money, that means you can be more productive. 

• Search everything. You already know that you can search the 
files on your Mac easily. Wouldn’t it be great if an electronic search 
could also turn up documents you’ve received in the mail, your old 
school records, business cards you received years ago, posters you 
saw hanging at the supermarket, and any other piece of text you 
encounter? (How about this: It took me about 2 minutes to deter-
mine that my father got an F on his final French exam in 11th grade. 
I scanned all his old report cards!) 

• Share documents easily. Printing or photocopying documents—
and then handing them or mailing them to other people—is so 20th 
century. I can share digital documents with nearly anyone in a few 
clicks, and why shouldn’t that ease extend to paper documents? 

• Back up physical documents. You back up your digital photos 
and business documents (don’t you?), but what if your tax returns, 
insurance records, contracts, invoices, and other crucial paper files 
were lost in a fire or other disaster? Create digital versions and you 
can back them up too. As a bonus, you can give yourself remote 
access to all your scanned documents—something that’s tricky to 
pull off with paper! 

• Save the planet. I like to think I’m as concerned about the 
environment as the next guy, but to be honest, my desire to reduce 
paper consumption has nothing to do with saving trees, eliminating 
waste, shrinking my carbon footprint, or any such thing—although 
it does all that too! I do it because it makes me happier, and it just 
so happens that it’s good for the planet (at least in some small way) 
as well. 

Tip: To keep up with the latest in the world of paperless office 
news, visit Brooks Duncan’s DocumentSnap site or subscribe to 
his blog (http://www.documentsnap.com/). 

http://www.documentsnap.com/
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Understand Searchable PDFs 
Although a paperless office has many aspects, one central assumption 
is that many documents that are currently on paper will end up on 
your computer—in a single special format. That format is officially 
called “PDF Searchable Image,” but most people refer to it using the 
less-cumbersome term “searchable PDF.” Because this one unique 
format is the magical key that makes the whole system work, I want 
to give you a quick overview of the most common PDF (portable docu-
ment format) varieties so you can see where searchable PDFs fit. 

The PDF files most of us encounter daily were created in a program 
like Microsoft Word or Adobe Illustrator—nearly any application that 
can produce printed output. Except instead of printing, the document 
is saved in PDF format, which is relatively compact and looks more or 
less the same on any platform. When an application “prints” a PDF file, 
the PDF automatically contains searchable text. (There are occasional 
exceptions to this for text treated as objects, such as Word’s Word Art 
and Excel tables embedded in a Word document.) That means, among 
other things, that you can select and copy text in the document, and 
search engines such as Mac OS X’s Spotlight index their contents. This 
sort of run-of-the-mill PDF is officially called “PDF Normal.” 

Normal PDFs can include graphics—either vector artwork or bitmaps 
that originally came from a scanner or a digital camera. But the PDF 
format can also be used as a simple wrapper around plain bitmapped 
images (for example TIFFs and JPEGs) without any other content. 
This second sort of PDF is officially called “PDF Image Only.” 

When you scan documents, your scanning software will probably save 
PDF Image Only files initially. But then a second process occurs: opti-
cal character recognition (OCR), which identifies letters and words in 
the image. A few years ago, OCR produced a plain text file as output or, 
if you were lucky, an ugly Word file. But today the most popular way to 
handle the recognized text is to add it as an invisible layer above1 the 
                                            
1 For reasons I’ve never understood, most descriptions of the searchable PDF 

format emphasize that the text layer is below or behind the graphic. But that 

makes no sense—if it were underneath the graphic, you’d be unable to select it. 

It’s better to think of it as being above or in front of the graphic, but invisible. 
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bitmapped graphic, with the position of the live text corresponding 
to the position of the characters in the graphic. So, underneath you 
may have a graphic with dots that look like the word “sandwich,” and 
on top of that image is the text of the same word, which you can select, 
copy, or search just like the text in any normal PDF. This is the PDF 
Searchable Image, or searchable PDF format. 

The enormous advantage of searchable PDF over plain-text OCR 
output is that you can still see exactly what the original document 
looked like. And, if you were to print it again, it would look almost 
identical to the source document. Because no OCR tool is perfect, this 
also lets you verify what the document actually says, even if the text 
has some errors. 

OCR you sure that’s correct? Some OCR software lets you correct 
recognition errors on the fly or edit the hidden text layer after the 
fact, either of which can improve searching accuracy. However, I 
don’t generally recommend such manual intervention, because it 
makes the scanning process vastly more time-consuming. 

Meanwhile, the advantage over plain bitmapped images is that you 
can index, search, and use the text as text. So, if you’ve just scanned 
a stack of receipts, your scanning software may have given them all 
unintelligible names like “2010_10_22_09_35_25.pdf,” which would 
never help you find anything—at best you’d have to name them all 
manually, and at worst you’d have to look at each one to find a certain 
transaction. But with searchable PDF you can simply type a restaurant 
name into your search field and instantly see the receipt that mentions 
that name. 

Searchable PDFs are a wonderful thing, and because they’re the only 
way I know of to get this dual-layer effect automatically from an OCR 
application, every document you create as a result of using the instruc-
tions in this ebook will be in that format. 

Note: Some kinds of text, such as text in non-Latin languages, 
or even English text that uses advanced typography (ligatures, 
small caps, super/subscripts, etc.) may not be searchable when 
converted to PDF. If you are using such documents, check search-
ability before moving entirely to this format. 
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Consider Storage Options 
If your paper files are in a filing cabinet, then whatever disadvantages 
paper may have, you can at least be certain that none of the files will 
spontaneously evaporate, or lose part of their contents, due to a filing 
cabinet malfunction. Unfortunately, the same is not true of digital 
data. Digital files typically live on a hard disk somewhere. And hard 
disks, by their very nature, are subject to all sorts of problems ranging 
from random directory corruption to user error to theft, not to men-
tion just plain wearing out over time. So before you begin committing 
your files to disk—and especially before you get rid of the originals—
think about where and how you’ll store the digital files themselves and 
the physical media they rely on. 

I recommend, in particular, taking a moment at the outset to think 
about three main factors: disk capacity, local versus cloud storage, 
and media longevity. (Later in the ebook, I talk in more detail about 
another essential consideration: backups. See Back Up Scanned Data.) 

Disk Capacity 
If you follow the instructions in Configure Your Software, you’ll end up 
with nicely compact PDF files, and you may be able to fit hundreds or 
even thousands of pages worth of scanned data in just a few gigabytes 
of disk space. However, keep in mind that your data storage needs will 
inevitably grow over time. And, if you have tens of thousands of sheets 
to scan—especially if many of them are in color—you’ll need plenty of 
room for your data to expand. 

In these days when bare 2 TB drives can be found for under $100, it 
doesn’t make sense to skimp on capacity. If your Mac’s internal disk 
still has loads of free space, then you may be all set, but if in doubt, 
you might want to consider upgrading it to a more capacious model, 
or supplementing it with an external drive. 

Because there are so many hard drives to choose from, I can’t begin 
to give specific recommendations of brands or models. But I can say 
that for the purpose of storing your digital archives, it’s worth paying 
a bit extra for a drive with a longer warranty—5 years is the longest I’ve 
seen. And, all things being equal, if you purchase an external drive, buy 
one with the fastest interface your Mac supports. For example, eSATA 
is faster than FireWire 800, which is faster than FireWire 400, which 
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is faster—in practice if not on paper—than USB 2.0. (Faster even than 
eSATA is USB 3.0, but as of late 2010, only a handful of USB 3.0 drives 
have appeared, and no Macs have USB 3.0 ports; rumor has it that 
future Macs may support the still-faster Light Peak standard, about 
which you can read at http://en.wikipedia.org/wiki/Light_Peak.) 
Check to see which ports your Mac has, or which you can add by way 
of a PCI or ExpressCard adapter. 

Tip: If you need even more capacity than the largest available 
hard drives, an easy way to combine multiple drives is to use one 
of the many Drobo storage devices (http://www.drobo.com/), 
which can be upgraded easily to hold more data at any time. 

Local vs. Cloud Storage 
Although hard disks are still, in 2010, the main medium used for 
storing digital data, those disks need not sit in your office. They might 
just as easily be attached to a server somewhere in the bowels of an 
anonymous data center halfway around the world. Large companies 
that traffic in data storage and transfer (including the likes of 
Amazon.com, Apple, and Google—and countless thousands of others) 
offer data storage in the “cloud” at reasonable rates—perhaps less per 
year than what it would cost you to buy a new hard drive. 

The advantages of cloud storage for your formerly paper documents 
are many—for example: 

• Space savings. Hard drives take up space in your office, so if 
they’re not in your office, you have less clutter. 

• Accessibility. With cloud-based storage, you can access your data 
from any computer in the world with an Internet connection, which 
may not be true of disks in your home or office. 

• Redundancy. Cloud storage providers generally use RAID along 
with automated backups to protect your data against drive failures 
and user error. And, when used in conjunction with local storage, 
cloud storage gives you a second, offsite copy of your data that 
provides extra insurance against hardware and software gremlins. 
(Cloud storage as such isn’t necessarily the same as online backup, 
however; see Back Up Scanned Data for details on the latter.) 

http://en.wikipedia.org/wiki/Light_Peak
http://www.drobo.com/
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• Maintenance. If a hard drive in your office dies or runs out 
of space, you have to buy a new one and copy your data from a 
backup—a lengthy and tedious process. Cloud storage providers 
have systems in place to keep their equipment up to date and in 
good working order, relieving you of that burden. 

The biggest downside to cloud storage is that it’s much slower to copy 
data to or from the cloud than to store it locally. Unless you work for 
a large company with an Internet connection that costs more than the 
CEO’s annual salary, you’ll get dramatically better speeds with local 
hard drives. If the amount of data you want to store in the cloud 
reaches the tens of gigabytes or more, expect it to take weeks to upload 
over a moderately fast broadband connection. 

There are ways around this—for example, some online storage services 
let you fill a hard drive and send it to them via courier in order to seed 
your online space; then, you can simply add files to it as you go, which 
is far quicker. Even so, other potential problems remain. What if your 
Internet connection goes down and you can’t get at your files? What 
if the storage provider goes out of business? The potential perils of 
cloud-based storage are such that I wouldn’t recommend it as the sole 
place to keep your valuable scanned documents. However, I think the 
cloud makes an excellent secondary location for such files (just as it 
does for backups). 

Cloud storage providers are multiplying quickly, and I wouldn’t even 
attempt to catalog all the options. However, I can call your attention 
to a few services that let you store a significant volume of files online 
at a reasonable cost and (in one way or another) sync them with your 
Mac so that you can simply save files in one location and have them 
automagically transported to the other as well. Some examples: 

• Dropbox: Sync files across Macs, Windows PCs, and iOS devices. 
Dropbox offers excellent performance and compatibility, and I’ve 
become a big fan. Anyone can store 2 GB of data for free; 50 GB 
of storage costs $9.99 per month, while 100 GB of storage goes for 
$19.99 per month (https://www.dropbox.com/). 

• Google Docs: Along with Web-based editing of word processing, 
spreadsheet, and presentation documents, Google Docs lets you 
store files of any type. You can upload and download them using a  

https://www.dropbox.com/


18 

Web browser or any of numerous clients for Mac OS X and iOS. 
You get 1 GB of storage free (although individual files must be no 
larger than 250 MB); additional storage is $0.25 per gigabyte per 
year (http://docs.google.com/). 

• MobileMe: Apple’s $99-per-year MobileMe service includes, 
among many other features, online storage space called iDisk that 
you can access easily in the Finder, in a Web browser, or via an app 
on your iOS device. Standard accounts include 20 GB of storage 
shared between iDisk and email; you can configure the proportion 
used for each. Additional storage is available for a fee 
(http://www.apple.com/mobileme/). 

• SugarSync: This service lets you sync files and folders across 
Macs, Windows PCs, and a variety of mobile gadgets (including 
iOS devices). It also lets you share and sync files with other people. 
Plans start at $4.99 per month or $49.99 per year for 30 GB of 
storage; a free 30-day trial is available 
(http://www.sugarsync.com/). 

• Syncplicity: In much the same vein as SugarSync, Syncplicity 
lets you sync your data up to the cloud, and down to other Macs 
and Windows PCs. (At the moment, the only iOS app that accesses 
Syncplicity accounts is called MKSync. The app itself is free, but in-
app purchases are required to download files [$2.99] or share then 
[$1.99].) Syncplicity gives you 2 GB of storage (and access from 
two computers) free. A Personal Edition plan that costs $15 per 
month gives you 50 GB of storage and the capability to sync five 
computers; higher-capacity business plans are also available 
(http://www.syncplicity.com/). 

Media Longevity 
As I mentioned earlier, hard drives, like all mechanical devices, 
eventually wear out. So if you’re using them to store documents you 
need to keep indefinitely, you should make accommodations for the 
drives’ likely life spans. (The same, of course, is true of any media—
CDs, DVDs, and even flash storage degrade over time, although at 
least in those cases you need not worry about mechanical wear.) 

http://docs.google.com/
http://www.apple.com/mobileme/
http://www.sugarsync.com/
http://itunes.apple.com/us/app/mksync/id335572466?mt=8
http://www.syncplicity.com/
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Specifically, I suggest incorporating the following into your paperless 
office plan: 

• Replace your physical media every 3–5 years. I begin to 
lose faith in hard drives after about 3 years of continuous use, and 
after 5 years or so, I don’t trust them at all. (Of course, I generally 
upgrade all my computers every 2–4 years anyway, so new hard 
drives are just part of the deal.) Conventional recordable CDs and 
DVDs tend to last longer—especially if they’re not used frequently 
and are kept in a cool, dry, dark place. But for long-term storage, it’s 
still a smart habit to copy all your files onto fresh new media every 
3–5 years (and verify that all the files on the new media are intact). 

In the electric mist: Cloud storage providers automatically 
upgrade their hard drives, migrating your data in the process, 
when needed to ensure data continuity. 

• When feasible, buy higher-quality media. A name brand 
hard drive with a 5-year warranty isn’t guaranteed to last longer 
than an off-brand model with a 1-year warranty, but the odds are in 
your favor. Similarly, it’s possible to buy rather pricey archival CDs 
and DVDs, which the manufacturers claim will last much longer 
than ordinary optical media. 

• Don’t forget to back up! Backing up your data is always essen-
tial, but never more so than when you choose to dispose of original 
paper copies. A backup can save you from worn-out media among 
dozens of other problems. See Back Up Scanned Data for details. 
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A Word about Screen Dependency 
You may notice that in reducing your reliance on paper, you’re 
increasing your reliance on digital displays (computer monitors, 
iPhones, iPads, or whatever). This fact may have some 
unexpected consequences, so please consider doing the following: 

• Expand your screen real estate. You can easily spread out 
dozens of pages on a table and see them all at once, but if your 
only means of looking at digital documents is a single 15-inch 
display, you can only see, at best, one less-than-full-size page 
at a time. Monitors are getting larger and less expensive all 
the time, so you may want to think about buying more and/or 
larger displays. 

• Think small, too. Although my iPad’s display has only a frac-
tion of the pixels of my 17-inch MacBook Pro, it lets me view 
digital documents in a wider variety of locations—and makes 
an excellent supplemental screen when I’m at my desk. You, 
too, may benefit from one or more smaller displays. 

• Have a backup. The more you depend on digital displays, 
the more important it is for you to have a Plan B if one of them 
dies. This might include buying the AppleCare Protection Plan 
for your Mac, iPhone, iPad, or iPod touch; making sure your 
homeowner’s or renter’s insurance covers theft or accidental 
damage to your displays; setting aside money in your budget 
for rapid replacements if needed; or keeping an inexpensive 
spare display on hand for emergencies. 

Envision a Paperless Future 
All right, you’ve seen the benefits of a paperless office and you know 
some of the details about where you’re headed—document formats 
and storage media and so forth—but what does your future day-to-day 
work look like without all the paper? If you can picture it, you’re 
more likely to make it happen. When you get to the chapter Create a 
Workflow for Incoming Paper you can read all the details, but in the 
meantime, here’s the overall vision I’d like you to aim for: 

• You enjoy a clean desktop. Where once stood stacks of papers 
(not to mention magazines and books), you now have clear view of 
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your actual desktop, which you may not have seen in years. You can 
use that space for a second monitor, or an iPad, or pictures of your 
kids. And as your filing cabinets begin to empty out, you think about 
putting a nice decorative ficus in their place. 

• You receive much less incoming paper. You’ve taken meas-
ures to ensure that most of the documents coming your way do so 
electronically, so you’re not spending hours a day scanning. 

• You use your scanner regularly. You may still (or for the first 
time) have In and Out boxes, but they’ll take on new meaning. In 
will contain papers you’ve only just received and will scan by the 
end of the day. Out will contain papers that have been scanned, and 
can be shredded, recycled, or filed. In between them sits a shiny 
scanner, which has become your new best friend. (I elaborate on the 
setup you might employ later, in Create a Physical Paper Path.) 

• You practice good habits. Scanning need not be labor-intensive 
at all; you can set things up (see Configure Your Software) such that 
you do nothing more than press a button and move on to the next 
document. However, you may choose to get in the habit of expend-
ing a wee bit more effort as you scan to make it easier to find docu-
ments later. In any case, you’ll scan all incoming documents as soon 
as reasonably feasible after you receive them. 

• You can find documents easily. When you need a document 
you’ve scanned, you usually know exactly where to look on your 
hard disk. Using either the Finder or any of numerous document-
management tools, you do a quick search for anything whose 
location isn’t obvious, and it appears on your screen in seconds. 

• You generate little or no outgoing paper. Your printer may 
be used so seldom it gets lonely. It’s still there for times when paper 
is obligatory, but you no longer print, photocopy, or mail paper as 
a matter of course. 
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Getting Others Onboard 
Intelligent and forward-thinking person that you are, you’ve 
grasped the value of switching from paper to digital, and you 
may be ready to tackle the transition with great vigor. However, 
less-enlightened coworkers or family members might put up 
resistance, especially if they worry that a paperless office will 
involve significant expense or force them to change long-held 
habits. 

If you’re going paperless purely for your own benefit, it might 
not matter whether others do likewise, but in a business setting, 
getting rid of paper could be disruptive and frustrating unless 
everyone involved buys in to the plan. And even at home, kicking 
the paper habit will be far easier if everyone shares your vision. 
Here are some tips to do just that: 

• Review the benefits. Play up the factors listed in Learn the 
Benefits of Ditching Paper according to what’s most important 
to your audience (money, efficiency, environment, etc.). 

• Lead by example. Convert your own documents to digital and 
demonstrate your increased productivity and decreased clutter.  

• Display adaptability. Be prepared to meet others halfway, to 
consider alternative proposals, and to bend on your top choices 
for hardware and software. Some change is better than none. 

• Promise them toys. With certain people, this works wonders: 
“Cancel your paper magazine subscriptions and I’ll buy you an 
iPad.” Or: “I’ll approve your request for a larger monitor if you 
agree to start using electronic invoices.” 

• Think about the kids. Young children tend to feel ignored 
when their parents are staring at screens. But it’s less of a 
problem if the screens are smaller and handheld, because this 
lets you change your position and look at the kids more. And 
remember, Dr. Seuss iPad apps are great (I’m speaking as the 
parent of a young child here), but actual paper books, which 
your child can hold, throw around, and gnaw on, are better 
when a parent isn’t supervising. 
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Head Off Most Paper 
before It Reaches You 
 
In the chapter after this one, we begin the process of selecting, 
setting up, and using a scanner to digitize your papers. Once that’s 
done, you’ll be able to dispose of (most of) the originals so they no 
longer clutter your office. That’s great—but wouldn’t it be better still 
if the paper never reached you in the first place? 

Before we attack the current and future paper flow, it makes sense 
to find as many ways as possible to prevent paper from arriving at 
your desk at all (assuming, of course, that you can obtain suitable 
digital replacements). This chapter provides a few ideas along those 
lines. 

Sign Up for Paperless Billing 
Most banks, insurance companies, utilities, phone companies, peri-
odicals, schools and colleges, tax offices, and other entities that expect 
money from you on a recurring basis offer some form of paperless 
billing and payment. In fact, this practice is becoming so prevalent that 
some companies now charge extra for paper bills, while others no long-
er offer them at all. Details vary, but in a typical case you set things up 
such that you receive bills or statements by email, and then pay either 
by credit card or by preauthorized bank withdrawal. 

I’m a big fan of paperless billing, and use it as much as possible. With-
out it, I have to contend with a paper check (and frequent checkbook 
refills), a payment stub, a stamp (often), and a return envelope. And 
after all that, I still have an outer envelope (into the recycling bin) and 
a paper bill I’ll probably never look at again (into the filing cabinet). 

On the other hand, with paperless billing I generally get a PDF copy 
of my statement that I file on my disk and the convenience of paying 
in a few clicks—or, in many cases, none at all. In the case of automatic 
payments, I also get peace of mind knowing that a faulty memory, 
illness, or other distraction won’t leave me in the dark or the cold. 



24 

So your first mission is to think about what sorts of recurring pay-
ments you make that require an exchange of paper, and see if the 
payee offers a paperless option. The easiest way is simply look online 
every time a paper bill appears in your mailbox. 

However, before you go crazy making everything paperless, spend a 
few moments pondering the following: 

• Is your email under control? If you have such an overloaded 
Inbox, or a flaky spam filter, that you’re likely to miss emailed 
payment notices, you might want to think twice. Also, you might 
want to read my Macworld article “Empty Your Inbox,” at 
http://www.macworld.com/article/139510/! 

• Do you have a fallback plan? An emailed payment notice isn’t 
much good if you’re away from your email for a long time—if you’re 
on vacation, sick, or otherwise incapacitated. Does your spouse or 
significant other have a reliable way to check and pay your bills? If 
not, talk it over and devise a plan before committing yourself. 

Tip: If you set up a special email address that you use only and 
always for bills, and make sure both you and another person 
check that account regularly, you’re less likely to miss billing 
notices. 

• Do you monitor balances and schedules carefully? I 
check my bank balances several times per week, and I have alerts 
in my calendar reminding me about upcoming payments, so I can 
be certain there’s enough money in the right accounts to pay bills 
when they come due. If you do too (or if you’re willing to change 
your habits to check your balances regularly), paperless billing is 
a good fit for you. 

As a corollary, keep in mind that sometimes things Just Don’t 
Work. Random server or router outages, or other gremlins in the 
ether(net), might cause a notice not to arrive, or an alarm not 
to sound. If you depend utterly on something being “in your face” 
to remind you about important payments, take the occasional 
failings of technology into account. 

If you use paperless billing, whether by choice or not, please take one 
piece of advice: always download your statements. That is, if the payee 

http://www.macworld.com/article/139510/
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offers PDF copies of your statements, be sure you keep local copies, 
and that you download them as soon as they’re available. More than 
once I’ve needed to refer to a statement urgently for some reason and 
found that at just that moment, the payee’s site was down for mainte-
nance, or only the last three months’ statements were available and it 
was now four months later, or some other problem had arisen. Down-
loading statements as they come online prevents that sort of thing. 
 

Other Electronic Payment Options 
What if a payee doesn’t offer a paperless option? This may be true 
of your landlord, newspaper carrier, day care facility, martial arts 
teacher, or other people and businesses. Here are some ideas: 

• PayPal: Ask the payee if you can pay using PayPal. Some 
people love PayPal and some people hate it, but I’ve found it 
useful to make certain kinds of electronic payments that would 
otherwise require lots of cumbersome paper and inconvenience. 

• Online bill payment: Many banks (and some personal finance 
programs) let you electronically request that a payment of 
an arbitrary amount be made to a given person and address. 
The bank or payment processor deducts the money from your 
checking account, prints out a check, and mails it to the 
payee—but you never have to deal with the paper yourself. 

• Wire transfers: For recurring payments, especially for larger 
amounts like rent, your bank may be able to set up a repeating 
wire transfer direct to the payee’s account. 

Choose Online Bank Statements 
Just as you can usually receive and pay bills electronically, you can 
usually do the same with monthly bank statements. Most banks and 
credit unions in the civilized world let you download your statements 
as PDF files—either instead of, or in addition to, receiving paper 
statements in the mail. Needless to say, my own preference is to forgo 
paper entirely, but even if you keep receiving paper statements, I 
suggest downloading the PDFs, because that’s quicker and easier than 
scanning them yourself—and it gives you a handy, searchable copy of 
your bank records on your hard disk. 
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Receive Invoices Electronically 
If your work involves paying invoices sent by other people or com-
panies, you can request that they send them electronically rather than 
on paper. (For the flip side—sending out your own invoices—see Send 
Invoices Electronically, later in this ebook.) Virtually anyone—and any 
accounting or billing software—can generate an invoice in the form of 
a PDF or Word (.doc) file, which can then be sent by email. If you’ve 
always relied on paper invoices, this will naturally involve some 
changes to your workflow for making payments, and the details are 
beyond what I can cover here. But I merely want to point out that you 
need not continue receiving unwanted paper invoices; your suppliers 
or contractors almost certainly have the capability and willingness to 
switch to electronic files. 

Explore Other Paperless Options 
As you begin paying attention to the sources of incoming paper, you’re 
bound to discover other opportunities for turning off the flow of atoms 
and replacing them with bits. Let me give you some suggestions to spur 
your imagination: 

• Catalogs: I’m always a bit shocked to get a paper catalog in the 
mail, given that the vast majority of the world’s retailers have most 
or all of their wares listed on a Web site—and often, have PDF 
versions of their catalogs available for download too. (My guilty 
pleasure: the printed IKEA catalog. I also prefer the analog version 
of their Swedish meatballs.) 

If you find it overwhelming to contact each company that sends 
you catalogs, visit Catalog Choice (http://www.catalogchoice.org/), 
which offers a central location where you can unsubscribe from 
mailings of catalogs, coupons, phone books, and other advertising 
from a long list of U.S. companies. 

• Junk mail: You may not be able to entirely stop junk mail, but you 
can certainly put a big dent in it by using the following resources: 

◊ A free PDF (http://stopjunkmail.org/sample/kit.pdf) from the 
Bay Area Junk Mail Reduction Campaign offers instructions for 

http://www.catalogchoice.org/
http://stopjunkmail.org/sample/kit.pdf
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anyone in the United States to opt out of credit card offers, 
sweepstakes, shopping flyers, and other direct mail. 

◊ Stop pre-approved credit card and insurance offers by filling out 
a form at https://www.optoutprescreen.com/. 

• Business cards: Rather than take someone’s business card, snap 
a picture of it with your smartphone or digital camera and hand it 
right back. (I say more about this later, in OCR on the Go.) 

• ATM receipts: I spent perhaps 25 years dutifully collecting my 
receipt every single time I withdrew money from an ATM, on the 
vague theory that they might someday, somehow come in handy 
between the time of the withdrawal and the time it showed up on 
my bank’s Web site. They never did, so I broke that habit—and you 
can, too, assuming the ATMs you use give you that option. 

Get Paperless Postal Mail 
Let’s go a bit farther afield. I’m going to bring up something you may 
regard as unthinkable heresy, or the best thing since upside-down 
ketchup bottles. You can stop almost all of your postal mail entirely 
by redirecting it to any of several firms that will receive it for you and—
at your explicit request—open it, scan it, and deliver PDF copies of 
your mail online. You can do this not just for yourself but also for your 
entire business, and this can offer an astonishing degree of flexibility 
in dealing with your mail. 

I can feel some naysayers adopting a skeptical grimace already, but 
please hear me out. I’m speaking from personal experience here. 

Before I moved to Paris, I realized that I’d still want a U.S. mailing 
address for certain items that would be problematic to send directly 
to France. One of those things is checks: my French bank is happy to 
deposit checks in U.S. dollars, but only after charging me a huge fee, 
applying an unfavorable exchange rate, and making me wait a long 
time. For example, if my aunt sends me a $20 check for my birthday, 
I might as well just toss it—I’ll see so little of it that it’s not worth the 
trip to the bank. I could mail a check back to my bank in the States, but 
then I have to wait for it to make another transatlantic trip, and hope 
that it doesn’t get lost in the famously flaky French postal system. 

https://www.optoutprescreen.com/
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I discovered a company in Beaverton, Oregon called Earth Class Mail 
(http://www.earthclassmail.com/) that would receive and scan my 
mail for me, and—this was a big selling point—electronically deposit 
any checks I happened to receive into my U.S. checking account (see 
the sidebar Paperless Check Deposits, next page). In addition, I can 
order stuff online, such as electronics and DVDs from Amazon.com 
that can only be shipped to U.S. addresses, have it sent to this com-
pany, and then request that they forward-ship those items to me any-
where in the world. And that’s just the beginning. The company offers 
a wide range of mail processing services, all available from the comfort 
of my Web browser or an iPhone app. It’s expensive, but it’s been a 
tremendous help to me. 

I do still receive paper mail at home, but because most of the com-
panies I do business with have my Earth Class Mail address, the 
amount of paper I receive is greatly reduced. When I get junk mail, 
I see it in my account on the Web and click Recycle; for most official 
mail, I download the PDF and then click Shred. And if anything truly 
important comes along (like a new credit card), I have the company 
send it on via FedEx and I get it in a couple of days. 

Although my situation is unusual, such a service could be valuable 
for any person or business wanting to reduce paper and streamline 
information delivery. For a family, it can give you a quicker, easier way 
to get digital copies of your mail and a more efficient way of depositing 
checks—and, of course, you can always have the originals sent if you 
need them. A business of 50 employees could change its mailing 
address to that of a mail processing service, set up accounts for all 
50 employees, and have the service sort and electronically deliver all 
the mail rather than staffing a mailroom. 

Earth Class Mail charges either $19.95 or $39.95 per month to receive 
mail on your behalf and scan each piece’s exterior, depending on which 
range of services you want and for how many users. Other options, 
such as opening and scanning the contents of your envelopes and 
packages, depositing checks, and forwarding mail, require additional 
fees, as detailed at http://www.earthclassmail.com/Plans-And-Prices. 

Although Earth Class Mail is the service I personally prefer, and is the 
most full-featured service of its kind as far as I’m aware, numerous 
other companies will receive and scan your postal mail for you, some 

http://www.earthclassmail.com/
http://www.earthclassmail.com/Plans-And-Prices
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of them charging considerably less. You can see a helpful (if potentially 
biased) comparison table in a post on the Earth Class Mail blog at 
http://www.earthclassmail.com/blog/post/2010/08/24/The-truth-
about-pricing.aspx. 
 

Paperless Check Deposits 
Thanks to a piece of legislation passed in 2004 called the Check 
Clearing for the 21st Century Act (more commonly known as the 
Check 21 Act), it’s legal for banks and credit unions in the United 
States to accept digital copies of checks for deposit in lieu of paper 
checks. This process, which is called Remote Deposit Capture 
(RDC), is both faster and safer than dealing with paper checks. 

Not all banks accept deposits by RDC yet, and of those that do, 
some offer it only to business customers. In addition, some 
restrict the amount you can deposit electronically, and the process 
isn’t always perfect. However, more financial institutions are 
jumping on the bandwagon all the time. The latest twist is using 
an iPhone app provided by the institution to snap a picture of the 
front and back of a check and securely send it for deposit. 
Examples of RDC-friendly institutions include: 

• Chase QuickDeposit: Currently available only via a free 
iPhone app (https://www.chase.com/ccp/index.jsp?pg_name= 
ccpmapp/individuals/online_services/page/iphone-banking) 

• PayPal: Lets you deposit checks using an app on your iPhone, 
Android phone, or BlackBerry (https://personal.paypal.com/ 
us/cgi-bin/?&cmd=_render-content&content_ID=marketing_ 
us/mobile_iphone) 

• USAA Deposit@Home: Supports scans from scanners, 
iPhones, and Android phones (https://www.usaa.com/inet/ 
ent_utils/McStaticPages?key=bank_deposit) 

For a more complete list of financial institutions supporting RDC, 
visit http://paperless.wikia.com/wiki/Remote_Check_Deposit. 

http://www.earthclassmail.com/blog/post/2010/08/24/The-truth-about-pricing.aspx
http://www.earthclassmail.com/blog/post/2010/08/24/The-truth-about-pricing.aspx
https://www.chase.com/ccp/index.jsp?pg_name=ccpmapp/individuals/online_services/page/iphone-banking
https://www.chase.com/ccp/index.jsp?pg_name=ccpmapp/individuals/online_services/page/iphone-banking
https://personal.paypal.com/us/cgi-bin/?&cmd=_render-content&content_ID=marketing_us/mobile_iphone
https://personal.paypal.com/us/cgi-bin/?&cmd=_render-content&content_ID=marketing_us/mobile_iphone
https://personal.paypal.com/us/cgi-bin/?&cmd=_render-content&content_ID=marketing_us/mobile_iphone
https://www.usaa.com/inet/ent_utils/McStaticPages?key=bank_deposit
https://www.usaa.com/inet/ent_utils/McStaticPages?key=bank_deposit
http://paperless.wikia.com/wiki/Remote_Check_Deposit
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Choose a 
Document Scanner 
 
Although the steps in the previous chapter should help you to cut 
down on the volume of paper that comes into your life, it won’t stop 
it altogether—and it won’t eliminate all the paper you’ve already 
accumulated, either. So we move on to the next phase, which is 
scanning your documents so you have searchable digital copies, 
after which you can (at your discretion) recycle, shred, or file the 
originals. To accomplish this task, you’ll need a scanner—and not 
just any scanner. In this chapter I explain what makes an ideal 
scanner for this specific application, list a number of good candi-
dates, and help you decide which one to buy. 

I want to warn you up front that the type of scanner I recommend is 
not cheap—a $50 model probably won’t cut it. But if time is money, 
then you’ll recoup your investment many times over. 

Learn Why Document Scanners 
Are Different 
Eight or ten years ago, when I first realized I wanted a paperless office, 
I bought myself a scanner that, according to my research at the time, 
should have been just the ticket. It was a high-resolution flatbed scan-
ner (the kind typically used for scanning photographs) that came with 
an automatic document feeder (ADF) attachment, so I could lay a stack 
of papers in the tray, push the button, and—in theory—end up with 
scanned copies of all of them a few minutes later. But after trying this 
a few times, I got so frustrated that I gave up entirely. I want you to 
avoid making the same mistake, so let me explain the problems with 
my earlier setup: 

• My scanner was sloooooow. Admittedly, everything was slower 
in those days, and it wasn’t the most powerful scanner money could 
buy. But even at lower resolutions, scanning a single page could 
take minutes, and that was far too long. Part of the reason for this 
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was that the scanner was designed for precision and fidelity—
fantastic for photographs, but overkill for text documents. 

• It didn’t do duplex scans. The design of the scanner and ADF 
was such that it could scan only one side of a page at a time. So, for 
double-sided documents (as many of mine were), I had to scan one 
side of all the pages, flip over the stack, scan again, and then labor-
iously sort the images into the correct order. Yuck! 

• It had no OCR capability. Because the scanner was designed 
mainly for photographs, it didn’t include OCR software of its own, 
and I couldn’t find an affordable third-party OCR package at the 
time. 

• It required a lot of fiddling. I had to put a lot of thought and 
effort into selecting the right combination of settings for each 
document—the scanner wasn’t smart enough to figure out whether 
a page was color or black-and-white, what size it was, how to 
straighten it if it was crooked, and so on. It took a lot of extra 
manual effort to process the scanned files. 

So that experiment was a bust, but I learned a lesson: for document 
scanning, what you need is a document scanner—a device that’s 
designed expressly for that task. And most flatbeds—even newer, faster 
ones with duplex ADF capabilities—are not the best tool for the job. 
(I’m not knocking flatbeds, by the way. They’re fantastic for scanning 
photos, books, and large or irregular papers. But if you need to plow 
through thousands of letter/A4-sized sheets of mostly text, not so 
much.) 

This, that, and the other: What’s true for flatbed scanners also 
goes for multifunction devices that combine printer, scanner, copier, 
and (sometimes) fax into one box. Even if they have an ADF, they’re 
most likely unsuitable for the type of scanning I discuss in this book. 

Typical desktop document scanners look somewhat like fax machines: 
you load the pages to be scanned in the top, and the scanner pulls them 
through quickly (often at a pace of 20 pages per minute or more), 
scanning both sides at once. (Compare this with some duplex flatbed 
scanners that require two passes to scan both sides of a page—even if 
the process is automated, it still takes twice as long.) 
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What’s the catch? Well, you trade off resolution, for one thing; 
document scanners usually max out at 600 dpi, whereas 4800 dpi 
is more common for flatbeds. But it turns out that for this type of 
scanning, lower resolution is exactly what you want—and as I explain 
ahead, in Set the Resolution, there are good reasons to go even lower 
than 600 dpi. 

Another trade-off is that document scanners limit the dimensions of 
your documents. Letter- and legal-size pages are no problem, and most 
of them can handle smaller sizes, such as business cards and receipts, 
too. But larger pages, materials that are especially thick or stiff, and 
extremely delicate papers often pose problems for document scanners. 

Even so, for the vast majority of office-type scanning, the benefits of 
document scanners far outweigh their limitations. 

A subcategory of document scanners includes those designed for 
portability. In most cases, this means giving up an ADF, settling for 
slower speeds, or both. A few convertible models attempt to give you 
the best of both worlds by offering a detachable ADF, leaving you with 
a small, portable, manual-feed scanner. 

Consider Important Scanner Features 
I’ve already mentioned a few features to look for in a document 
scanner, but let me expand on that list: 

• Single-pass duplex. All modern desktop document scanners, 
and about half the portable scanners, offer duplex (double-sided) 
scanning in a single pass, thanks to a pair of facing sensor arrays. 
The rest of the portable document scanners are simplex (single-
sided), meaning for double-sided pages you must manually feed the 
paper in, flip it over, and then feed it in again. 

• An automatic document feeder (ADF). For desktop scanning, 
and ADF is a no-brainer; without it you’d have to babysit the scan-
ner whenever you scan multi-page documents. ADF capacities for 
consumer-level desktop document scanners range from about 20 
to 75 pages, so if you have lots of long documents, a higher capacity 
might be of interest. Some portable scanners have ADFs and some 
don’t; those that do are, naturally, bulkier and heavier. 
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• Scanning speed. Document scanners usually specify two 
measurements: pages per minute (ppm) and images per minute 
(ipm). An image is a single side of a page, so for single-pass duplex 
scanners, the ipm value is double that of the ppm figure. For sim-
plex scanners, ppm and ipm are the same. For the class of scanners 
I cover here—geared toward consumers and SOHO (small office, 
home office) customers—a scanning speed of 25 ppm (or 50 ipm) is 
considered fast, 20 ppm or so is normal, and anything under about 
10 ppm is slow—although still much faster than most flatbeds! Be 
aware, though, that portable scanners are nearly always slower than 
desktop models, and among portables, those that rely on a single 
USB cable for bus power tend to be the slowest. 

• Ultrasonic double feed detection. A small but growing number 
of document scanners have a special sensor that can detect when 
two or more pages are stuck together and going through the scanner 
at the same time. These scanners can alert you to that fact so you 
can separate the pages and re-feed them—but they won’t fix the 
problem for you automatically. 

• Automatic document type detection. Most document scanners 
can automatically determine whether a document is single- or 
double-sided, what size it is, and whether it’s color or black-and-
white—and choose the appropriate settings and output format 
without any manual intervention. Those that don’t require extra 
work on your part. 

• Duty cycle. Some scanners—typically those with more of a 
business focus—are rated for a duty cycle, which in this context 
means the number of pages it can handle per day without excessive 
wear or overheating. Duty cycles in the range of 500–1,000 pages 
per day are common for the type of scanner I discuss in this book. 
Of course, a 20 ppm scanner can, in theory, feed through 1,000 
pages in less than an hour, but due to practical limitations (such 
as managing the paper before and after the scan, naming and/or 
tagging the digital files, and so on), most of us will never approach 
that limit. Still, if you have a truly massive amount of paper to scan 
and are highly motivated to do it in a hurry, you should keep an 
eye on the duty cycle specification. 
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• Built-in software features. Each document scanner includes 
software of some sort—at minimum, a basic driver or application 
that enables your Mac to communicate with the scanner and deter-
mine what happens with its output. Some of this manufacturer-
supplied software includes useful extra features such as automatic 
cropping, deskewing of images that are slightly crooked, removal 
of blank pages, and reorientation of images that are upside-down 
or sideways. Such capabilities are handy, but it doesn’t ultimately 
matter much whether these tasks are performed during the initial 
scan or during post-processing by a third-party application. If the 
scanner’s own software doesn’t do everything you need, one of the 
bundled programs—or an application you purchase separately—
certainly can. 

Note: Be sure to read the next chapter, Choose OCR Software, to 
learn about the capabilities of many third-party OCR programs, 
including those bundled with a number of popular scanners. 

• Bundled software. In addition to the manufacturer’s software 
for basic scanner operation, some manufacturers offer much more 
sophisticated third-party tools that let you choose various types 
of automatic processing and filing for scanned images. Scanners 
are often bundled with applications such as Readiris or ABBYY 
FineReader for OCR, and sometimes include other applications for 
document management, photo editing, or PDF manipulation. These 
may either be full, stand-alone packages or feature-limited, custom-
ized versions of the software that work only with images coming 
direct from the scanner. Some scanners include software designed 
specifically for OCR on business cards or receipts—intelligently 
turning their data into Address Book records or database entries. 

Before you decide which model to buy, you might want to read 
about some of this extra software in the next chapter (Choose OCR 
Software), because you may be able to save money by choosing a 
scanner that includes software you’re interested in. But with the 
sole exception of the Doxie, every scanner I discuss here comes with 
software that can create searchable PDFs, and almost any combina-
tion can be made to work effectively for most people. But remember 
that you can always add the third-party software of your choice 
later, so don’t sweat the decision too much one way or the other. 
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Never the TWAIN 
Some manufacturers tout the fact that their scanners include 
TWAIN drivers, while others (including Fujitsu) take pains to 
emphasize that they don’t. What in the world does that mean? 
TWAIN, which is commonly though incorrectly thought to stand 
for “Technology Without an Interesting Name” (it doesn’t stand 
for anything, in fact), is an industry-standard protocol by which 
an application can talk to a scanner or digital camera. It’s great 
in certain situations—for example, Photoshop and Apple’s Image 
Capture utility work with TWAIN-compatible devices, allowing 
you to scan images directly into those applications. 

For document scanning, however, TWAIN support is neither here 
nor there. As long as the scanner includes Mac OS X software that 
can turn its output into a bitmapped file—and they all do—you can 
get along perfectly well without TWAIN. TWAIN is good for manual 
interaction with scanners, but the workflow I recommend is almost 
entirely hands-off—your scanner produces an image file, which is 
automatically fed through OCR software to produce a searchable 
PDF. So unless you also plan to use your scanner along with con-
ventional image-processing software that expects TWAIN com-
pliance, you can take or leave TWAIN drivers. 

Pick a Mac-Compatible Scanner 
In recent years the market for document scanners has blossomed, 
although a good many models ship with software only for Windows 
PCs. However, Mac users still have at least a dozen options, which 
cover a considerable gamut of price, features, and size. This list isn’t 
exhaustive, but rather a representative sampling. Manufacturers add 
new models and discontinue old models regularly, so I encourage you 
to do your own research before settling on a scanner to see if a newer 
or different model may suit you better. 

The scanner models that I discuss next are divided into three broad 
categories: Desktop Scanners for models meant to remain in one place; 
Convertible Scanners for models that work well enough on a desk, but 
let you separate the scanner itself from the document feeder so you can 
take it with you; and Portable Scanners that make more significant 
trade-offs in favor of mobility over full features.  
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All the following scanners have an optical resolution of 600 dpi and 
connect via USB. Prices shown are manufacturers’ suggested retail 
prices, but street prices are frequently much lower. 

Desktop Scanners 
In an office, where speed and efficiency are primary concerns and 
you have a bit of spare desk space, a conventional desktop document 
scanner is the logical choice. Mac-compatible models include these: 

• Canon imageFORMULA DR-2510M: This speedy scanner zips 
along at 25 ppm/50 ipm. It has a 50-sheet ADF and ultrasonic 
double feed detection. Software includes Canon CaptureOnTouch, 
NewSoft Presto PageManager, NewSoft Presto BizCard Reader 
(OCR for business cards), and a TWAIN driver. 
(http://www.usa.canon.com/cusa/consumer/products/scanners/ 
document_scanners/imageformula_dr_2510m_workgroup_ 
scanner, $795) 

• Canon imageFORMULA DR-2010M: Almost a clone of the 
much pricier DR-2510M, the DR-2010M offers the same software 
bundle and similar specs—except it’s a bit slower (20 ppm/40 ipm) 
and lacks the ultrasonic double feed detection. 
(http://usa.canon.com/cusa/consumer/products/scanners/ 
document_scanners/imageformula_dr_2010m_workgroup_ 
scanner, $555) 

• Epson WorkForce Pro GT-S50: The GT-S50 has the highest-
capacity ADF of any scanner in this ebook—75 sheets. It also has a 
high duty cycle of 1,200 pages per day, not that you’re likely to hit 
that limit. It offers brisk 25 ppm/50 ipm duplex scanning, and its 
bundled software includes Epson Scan, ABBYY FineReader Sprint 
Plus OCR, NewSoft Presto BizCard 5, and a TWAIN driver. 
(http://www.epson.com/cgi-bin/Store/jsp/Product.do?sku= 
B11B194011, $500) 

• Fujitsu ScanSnap S1500M: Fujitsu’s ScanSnap models have 
been a favorite of Mac users (including yours truly) for years. The 
S1500M includes a 50-sheet ADF, scans in duplex at 20 ppm/40 
ipm, offers ultrasonic double feed detection, and comes with 
ScanSnap Manager, Quick Menu, Acrobat 8 Professional, ABBYY 
FineReader for ScanSnap 4.0 Mac Edition, and Cardiris 3.6 for 
ScanSnap—but not TWAIN support, for what it’s worth. 

http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2510m_workgroup_scanner
http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2510m_workgroup_scanner
http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2510m_workgroup_scanner
http://usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2010m_workgroup_scanner
http://usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2010m_workgroup_scanner
http://usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_dr_2010m_workgroup_scanner
http://www.epson.com/cgi-bin/Store/jsp/Product.do?sku=B11B194011
http://www.epson.com/cgi-bin/Store/jsp/Product.do?sku=B11B194011
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(http://www.fujitsu.com/us/services/computing/peripherals/ 
scanners/scansnap/scansnap-s1500m.html, $495) 

• NeatDesk for Mac: NeatDesk offers duplex scanning at “up to” 
24 ppm/48 ipm and has a 50-sheet ADF. Well, I should clarify 
that—it includes a special paper input tray that holds up to 15 
business cards, plus 15 receipts, plus 15 letter-sized documents at 
the same time, in case you’re scanning a lot of mixed-size papers—
but you can remove this tray and instead enjoy the higher capacity 
(assuming all the pages are the same size). Although the scanner 
software includes TWAIN support, you’ll most likely want to use 
the included NeatWorks software, which not only does OCR but 
also offers specialized processing of business cards and receipts. 
(http://www.neatco.com/products/neatdesk-for-mac, $399.95) 

Convertible Scanners 
If you expect to do most of your scanning at your desk and want the 
advantages of a desktop scanner (namely, faster performance and 
an ADF) but also need to scan on the go occasionally, consider one 
of these convertible scanners. On your desk it looks and acts much 
like any other desktop scanner, but when you detach the ADF, you get 
a stand-alone, manually fed scanner mechanism that can operate on 
USB bus power. Examples include the following: 

• IRIScan Pro 3: On your desk, it has a 20-sheet ADF and offers 
15 ppm/30 ipm duplex scanning. Separate the scanner mechanism, 
and you have a USB-powered 7 ppm/14 ipm portable scanner. 
Comes with Readiris Corporate 12 and Cardiris Pro 5. 
(http://www.irislink.com/c2-1647-189/IRISCan-Pro.aspx, $399) 

• Visioneer Strobe 500: This scanner also has a 20-page ADF 
and scans in duplex at 15 ppm/30 ipm. It’s bundled with ExactScan 
Capture and NewSoft Presto PageManager. 
(http://www.visioneer.com/products/S500/, $399.99) 

• Xerox DocuMate 3115: Like the previous two models, this one 
has a 20-page ADF and operates at 15 ppm/30 ipm in duplex. You 
can detach the ADF to get a portable scanner, but there’s a slight 
catch: you must use two USB cables (or an AC adapter) to power it. 
Includes Nuance OmniPage Pro and TWAIN drivers. 
(http://www.xeroxscanners.com/en/us/products/DM3115/default.
asp, $399.99) 

http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/scansnap-s1500m.html
http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/scansnap-s1500m.html
http://www.neatco.com/products/neatdesk-for-mac
http://www.irislink.com/c2-1647-189/IRISCan-Pro.aspx
http://www.visioneer.com/products/S500/
http://www.xeroxscanners.com/en/us/products/DM3115/default.asp
http://www.xeroxscanners.com/en/us/products/DM3115/default.asp
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Portable Scanners 
All the scanners in this last group are marketed as “portable,” though 
that word has a range of meanings. 

Four of these scanners (the Doxie, IRIScan 2, IRIScan Anywhere, and 
NeatReceipts) are genuinely tiny, all weighing well under a pound. The 
Visioneer Strobe 400 is a step up in size and weight (1.6 pounds), but 
offers duplex scanning, which the smaller scanners lack. The Canon 
imageFORMULA P-150 slides farther along the scale, at about twice 
the size of the Doxie and three times the weight (about 2.1 pounds), 
while the Fujitsu ScanSnap S1300 is larger and heavier still, at around 
3.1 pounds—still portable, but only just. However, only the Canon and 
Fujitsu models (both also duplex-capable, by the way) include auto-
matic document feeders, which significantly increase their usefulness. 

All these scanners can run on USB bus power—no AC adapter 
required—which certainly does increase portability. 

Mac-compatible portable scanners worth considering include: 

• Doxie: Apparent’s much-ballyhooed, small, inexpensive scanner 
can send scanned documents directly to any of numerous cloud-
based services, if that’s your thing. However, it’s the only scanner of 
all those I cover in this ebook to ship without OCR software, which 
means you’ll have to find, buy, and configure an OCR application on 
your own—and you’re likely to sacrifice some ease of use because it 
won’t be as closely integrated with the scanner as is usually the case. 
Depending on your settings, you can expect up to 6 ppm/ipm from 
this manual-feed simplex scanner. 
(http://www.getdoxie.com/, $149) 

Tip: Read much more about my impressions of the Doxie, as well 
as the Fujitsu ScanSnap S1300 (mentioned just ahead in this list) 
in “ScanSnap S1300 vs. Doxie: Two Portable Document Scanners” 
(http://db.tidbits.com/article/11458). 

• Canon imageFORMULA P-150: This largish model (as portable 
scanners go) offers duplex scanning and a 20-sheet ADF; it can also 
scan at 15 ppm/30 ipm in black-and-white or grayscale, 10 ppm/20 
ipm in color, which is the fastest color scanning of any device in this 
class. But there’s a minor gotcha: you get such fast scanning only 

http://www.getdoxie.com/
http://db.tidbits.com/article/11458
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when use an AC adapter or run two separate USB cables between 
the scanner and your computer so it gets an extra boost of power—
otherwise, cut those figures in half. The P-150’s comes with Canon 
CaptureOnTouch and CaptureOnTouch Lite (the latter of which is 
built into the scanner itself), NewSoft Presto PageManager, NewSoft 
Presto BizCard, and TWAIN drivers. 
(http://www.usa.canon.com/cusa/consumer/products/scanners/ 
document_scanners/imageformula_p_150m_personal_document
_scanner, $295) 

• Fujitsu ScanSnap S1300: The largest and heaviest of these 
portable scanners, the ScanSnap S1300 is nevertheless quite 
capable, sporting a 10-sheet ADF and duplex performance of up 
to 16 ppm/32 ipm for grayscale documents and 8 ppm/16 ipm for 
color. But, like the Canon imageFORMULA P-150, it needs extra 
juice (supplied by an AC adapter) to reach maximum scanning 
speed. Without an adapter, you must always use two USB cables—
but you’ll still get only half the top speed. The software includes 
ScanSnap Manager, Quick Menu, ABBYY FineReader for ScanSnap, 
and Cardiris for ScanSnap, but not Acrobat Professional, as the 
desktop S1500M does. 
(http://www.fujitsu.com/us/services/computing/peripherals/ 
scanners/scansnap/s1300.html, $295) 

• IRIScan 2: Manufacturer I.R.I.S. publishes very little in the way 
of specifications for this nicely compact scanner—I can’t tell you 
how fast it is, but I do know that it’s a simplex scanner with no ADF, 
and that it’s bundled with Readiris Pro 11 and either an older or 
newer edition of Cardiris Pro, depending on which version you buy. 
(http://www.irislink.com/c2-1656-189/Overview-IRISCan-2.aspx, 
Express version with Cardiris Pro 3, $129; Executive version with 
Cardiris Pro 4, $169) 

• IRIScan Anywhere 2: Although superficially similar to the 
IRIScan 2, this scanner is unique in that it can scan without being 
attached to a computer at all—making it, in that sense, the most 
portable scanner of all these. Scans can be stored in 512 MB of 
internal memory, on an SD card (a 1 GB card is included), or on 
a USB flash drive, or internal memory (512 MB)—and then trans-
ferred to your Mac when convenient. The scanner is battery-
powered and recharges via USB. On the downside, it saves scans 

http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_p_150m_personal_document_scanner
http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_p_150m_personal_document_scanner
http://www.usa.canon.com/cusa/consumer/products/scanners/document_scanners/imageformula_p_150m_personal_document_scanner
http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/s1300.html
http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/s1300.html
http://www.irislink.com/c2-1656-189/Overview-IRISCan-2.aspx
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only in JPEG format, lacks an ADF, and scans only one side of the 
page at a time. Bundled software is Readiris Pro 12, Cardiris Pro 5, 
and ACDSee Express 2.0 for Mac (for photo management). 
(http://www.irislink.com/c2-1700-189/Overview.aspx, $199) 

• NeatReceipts for Mac: This is currently the tiniest Mac-
compatible portable document scanner—it’s slightly smaller than 
Doxie and a few grams lighter. It performs single-sided scans at 
up to 4 ppm/ipm portable and includes NeatWorks software. 
(http://www.neatco.com/products/neatreceipts-for-mac, $199.95) 

• Visioneer Strobe 400: If you want duplex scans on the go, this is 
the smallest scanner to offer that feature, although at a rather slow 
5 ppm/10 ipm and without an ADF. It’s bundled with ExactScan 
Capture and NewSoft Presto PageManager. 
(http://www.visioneer.com/products/S500/, $299.99) 

Even smaller: If you’re looking for serious portability, consider a 
pen- or wand-type scanner (see the sidebar OCR for Students and 
Researchers, later) as a supplemental device. 

Joe’s Scanner Recommendations 
In my estimation, modern document scanners are more alike than 
different, and you can probably get acceptable results with just about 
any of them. I’d urge you to look for three main things: 

• An ADF 

• Duplex scanning 

• OCR software 

You can get all that with any of the desktop or convertible models, and 
about half the portable models. If you spend a lot of time on the road, 
I’d have no hesitation recommending one of the tiny, ADF-less, 
simplex, portable scanners as a supplemental tool—but I wouldn’t 
suggest it as one’s only, or primary, scanner. 

If pressed to recommend just one brand of scanner, I’d give the nod to 
Fujitsu’s ScanSnap line, as I’ve used four different ScanSnap models 
myself, and I like both their hardware and their software. And, despite 

http://www.irislink.com/c2-1700-189/Overview.aspx
http://www.neatco.com/products/neatreceipts-for-mac
http://www.visioneer.com/products/S500/
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its slower speed and bulk compared to other compact scanners, I’m 
quite fond of the S1300 for both desktop and portable use—especially 
given how much less expensive it is than the desktop S1500M model. 
 

Sharing Scanners 
All the scanners I cover in this ebook connect directly to a single 
Mac using USB—and they require specific software to be running 
on that Mac. Even though Mac OS X includes a built-in scanner 
sharing feature, it doesn’t work with this sort of document scan-
ner. So if several people in your home or office want to share a 
scanner, you may run into problems. For example, if Phil wants 
to use the scanner hooked up to Tammy’s Mac, he’ll have to inter-
rupt her work, and then transfer his scanned documents back to 
his own Mac via file sharing—and Tammy will have to take pains 
to keep her own scans in a separate place. 

You can address problems like this in any of several ways: 

• Buy more than one scanner. Put one on the desk of each 
person who needs to scan regularly. 

• Have a Mac dedicated to scanning. Hook up your scanner 
to a centrally located Mac that isn’t needed for other activities. 
Configure it to save scans to a network-accessible location, and 
let everyone do their scanning there. 

• Buy a network document scanner. Several companies, 
including Canon and Fujitsu, make devices similar to the ones 
described here, but designed more as stand-alone computers 
with built-in scanners (or the other way around, depending on 
how you look at it). You connect them to your Ethernet network 
(no computer required), and use the either a touchscreen or 
built-in keyboard to direct scanned documents to an email 
address, a network volume, an FTP server, or even to a USB 
flash drive. These devices—which cost upwards of $2,000—are 
fast and have generous duty cycles, but they also require any 
OCR or other post-processing of scans to take place on individ-
ual users’ computers. 
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Choose OCR Software 
 
One way or another, you need software to turn your raw scans into 
searchable PDFs. OCR software of some sort most likely came with 
your scanner, but if it didn’t—or if you’re not happy with its features 
or accuracy—you have oodles of other choices. This chapter provides 
an overview of the major factors to consider when choosing Mac-
compatible OCR software, along with a fairly thorough list of appli-
cations from which you can choose. 

Determine Your Needs 
I haven’t personally tried every scanner and every OCR application 
mentioned in this book, but I’m going to go out on a limb and suggest 
that almost any combination of scanner and software can be made to 
yield acceptable results for the vast majority of users. I have my prefer-
ences, but based on the testing I’ve done, my sense is that unless you 
have unusual needs or are exceptionally picky, the path of least resist-
ance is simply to use whatever software came with your scanner (see 
Choose a Document Scanner) and not belabor the decision. 

As a result, I don’t go into tremendous detail in this chapter about the 
specifics of each and every OCR application. Rather, I stick with some 
fairly high-level concepts and suggest that if you’re curious about a 
particular application, you download a demo version (assuming the 
developer offers one; most do) and try it yourself. 

However, you may be the sort of person who should look more deeply 
into the capabilities of OCR tools before jumping in if any of the 
following statements apply to you: 

• You have (or plan to get) a Doxie. As of publication time, Doxie 
is the sole scanner, of those mentioned in this ebook, that doesn’t 
include any OCR software of its own. 

• You need to scan in multiple languages. All the OCR pro-
grams that I discuss here support English text, and most of them 
support at least a few other languages too. If you have documents 
in more than one language (and especially if you have documents 
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that mix more than one language on a page), you’ll need to look 
for OCR software that supports it, as I discuss in the next topic. 

• You want capabilities your existing OCR software lacks. 
Perhaps you’ve tried the software that came with your scanner and 
found it to be too slow, too cumbersome to use, or missing features 
you wish you had. If so, by all means look for a replacement! 

• You need more-advanced PDF processing features. Some 
of the OCR programs here do nothing but spit out a searchable PDF 
file, whereas others let you manipulate PDFs to your heart’s con-
tent. If you want fine-grained control over your searchable PDFs, 
look for such a program. 

If none of those needs describes you, feel free to skip to the next 
chapter, Configure Your Software. Otherwise, continue reading to 
learn about features to consider when evaluating OCR software. 

Consider Important OCR Features 
Comparing OCR applications for Mac OS X is less of a science than 
an art—and a messy one at that. The information available on devel-
opers’ Web sites varies tremendously in scope and detail. Some have 
elaborate user manuals, while others include only a brief how-to guide. 
Many offer downloadable demo versions, but some don’t. Developers 
use different terms to describe the same features, and have wildly 
divergent ideas about what constitutes a nicely usable interface. A 
feature that one developer considers too obvious to mention may be 
a main selling point for another. And although most of these appli-
cations claim to have outstanding OCR accuracy, objective measure-
ments are notoriously difficult to come by. 

In short, it’s harder than one might expect to form meaningful 
judgments about OCR software without trying them out (and even 
then, results may be ambiguous). However, a few factors are worth 
looking for: 

• Accuracy: No OCR software is 100 percent accurate, but, it’s 
been a long time since I used OCR software that didn’t come close 
enough to meet my basic searching and archiving needs. Never-
theless, because so many factors influence OCR accuracy—not 
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the least of which is the quality of the raw scans that your scanner 
produces—it’s possible for two people to have dramatically different 
results with the same application and even the same document. So, 
my advice is to take developers’ claims of accuracy with a teaspoon 
of salt. The best way to determine whether results are good enough 
for your needs is to try an OCR tool on freshly scanned documents 
from your scanner of choice. 

• Languages: If not all the documents you’ll scan are entirely in 
English, you need to pay attention to the software’s multilingual 
support. The first task of OCR software is to recognize individual 
characters. If a document contains characters that don’t appear in 
English (such as Ω or ø), your OCR software must know about those 
other character sets in order to interpret them properly—otherwise, 
they’ll be represented by the nearest equivalents in the English 
alphabet. Beyond that, nearly all modern OCR software uses 
language-specific dictionaries and algorithms to improve its accu-
racy dramatically. If a certain group of pixels might be either torn or 
tcm, a dictionary can compare those two strings and conclude that, 
for English, “torn” is the much more likely interpretation. The same 
goes for other languages—even if they use the same alphabet as 
English, you’ll get much better results if the program knows about 
the rules of that particular language. 

Even with support for multiple languages, though, OCR software 
may need help to narrow things down. If you specify upfront which 
language a document is in (something usually done via the soft-
ware’s preferences), you’ll get better results than if the software has 
to guess. Often, you can specify both a primary language and one 
or more secondary languages, to improve the odds that the software 
will use the right rules as needed. Even so, some OCR software that 
does perfectly well with pages that are entirely in a single language 
has trouble determining when languages change within a page. 
Once again, this is best judged by selecting some representative 
documents from your collection, scanning them using the settings 
I cover in the next chapter, and then checking to see what results 
the OCR software provides. Be sure to verify that they are, in fact, 
searchable, too. OCR software sometimes handles non-Latin text in 
ways that make searching (and even copying text) problematic. 
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• Automation support: Virtually all the applications here support 
at least a bare minimum level of automation—that is, there’s some 
way to configure them, perhaps in conjunction with your scanner’s 
included driver, such that newly scanned images are converted 
automatically into searchable PDFs without any need for manual 
intervention. (Sometimes this requires a bit of fiddling to set up 
initially, but I discuss that in the next chapter, Configure Your 
Software.) However, in many cases, better still is the capability to 
automate PDF processing in more elaborate ways using AppleScript 
or Automator, a topic that I discuss in Automate OCR, later. 

• Handwriting support: Recognizing text that was produced by 
a printer is relatively easy for a computer; recognizing handwritten 
text is considerably more challenging. A minority of OCR programs 
for the Mac claim to be able to recognize (neat, printed) hand-
writing to one degree or another, so if you need to scan lots of hand-
written notes, be sure to look for that feature. 

• Business card support: Any OCR program can recognize the raw 
text on a business card, but some have additional intelligence that 
enables them to infer (with mixed results) which string of text is a 
name, which is a title, which is a phone number, and so on—and 
then to put all those pieces into their appropriate fields in a data-
base record that you can then export to, or sync with, Address Book 
or another contact manager. If you scan lots of business cards, this 
capability can save you lots of manual effort. 

• Receipt processing: In much the same way as some OCR 
software recognizes the contents of a business card, other programs 
are designed to make sense of receipts—specifically looking for 
information such as date, merchant name, sales tax, and total, and 
storing that information in a database you can use for tracking 
expenses, preparing tax returns, and similar tasks. 

• PDF editing: A few of the applications I list ahead are designed 
mainly for creating, editing, annotating, optimizing, and otherwise 
transforming PDF files—with OCR merely being one of their many 
tricks. If you need such advanced features, then choosing one of 
these multifunctional applications may make your life easier. 

• Layout retention: Although the focus of this book is on creating 
searchable PDFs, sometimes you may need to convert a scanned 
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image into a live document you can alter in, say, Word or Excel. 
Several of the OCR programs listed ahead can do just that—creating 
editable documents whose layouts closely resemble those of the 
originals, including graphics, tables, and even similar fonts. 
Although the end result won’t be as faithful to the look and feel as 
a searchable PDF, it will be much easier to work with if you need to 
do anything other than search, read, and copy the text. 

• Document management: Once you have a searchable PDF, 
how do you search it? The answer may be Mac OS X’s system-wide 
Spotlight feature, in which case you can put the file in any conveni-
ent folder in the Finder. However, you may prefer an application 
that lets you tag, catalog, cross-reference, and search files with far 
greater flexibility and precision. If so, look for an application that 
includes not only OCR but also document management capabilities. 

With those thoughts in mind, let’s look at the range of OCR programs 
that you can choose from. (I offer my recommendations after the list of 
applications, in Joe’s OCR Software Recommendations.) 

Pick a Mac OCR Package 
A few years ago I’d have been hard-pressed to come up with more than 
three Mac applications that could perform OCR and produce search-
able PDFs. Nowadays, there are more than a dozen candidates, and 
more appearing all the time. I don’t guarantee that this list is complete, 
but it should give you a good idea of what’s available: 

• ABBYY FineReader Express for Mac: Customized versions of 
this software are often bundled with scanners, but ABBYY recently 
began selling it as a stand-alone product too. FineReader recognizes 
171 languages (and includes dictionaries for 36 of these), and it 
supports OCR on documents that mix up to three languages. It also 
offers limited support for recognizing hand-printed text. The soft-
ware offers a few image-manipulation tools, such as rotation and 
inversion, but is designed to be as simple and hands-off as possible. 
However, it doesn’t support AppleScript or Automator. 
(http://www.abbyy.com/finereader_for_mac/, $99.99) 

http://www.abbyy.com/finereader_for_mac/
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• Acrobat Pro: For thorough control over every aspect of PDF files, 
the top-of-the-line product in Adobe’s Acrobat line is the gold stan-
dard. It just so happens that OCR is among its talents. It recognizes 
text in 42 languages, of which you must pick one as the primary 
language. It also offers an option called ClearScan: if you choose, 
Acrobat Pro replaces the bitmapped image with text that closely 
approximates the fonts, styles, and layout of the original (although 
not in a form that can be edited in other applications). This can save 
a tremendous amount of disk space, and for many documents, the 
fidelity is quite good. Acrobat Pro also lets you perform OCR on 
documents in batches, and although its AppleScript support is sim-
plistic, with tinkering you can perform a fair amount of automation. 
(http://www.adobe.com/products/acrobat.html, $449; also 
included with some Creative Suite 5 bundles) 

Note: At publication time, Adobe had announced, and begun 
taking pre-orders for, Acrobat X Pro. Because I haven’t seen it 
yet, I don’t know how (if at all) its OCR features have changed. 

• Cardiris Pro: From the developer of Readiris (discussed later in 
this list), Cardiris Pro, a version of which is bundled with several 
scanners, specializes in identifying information on business cards, 
in order to create records that can be easily added to Address Book. 
(http://irislinktest.iriscorporate.com/c2-1109-189/Cardiris-pro-
4.aspx, $99) 

• DEVONthink Pro Office: Primarily designed as a document 
manager—and a fantastic one, at that, if I may say so—DEVONthink 
Pro Office lets you categorize, tag, sort, link, and search documents 
of all kinds with ease. And, not only does it come with an integrated 
version of ABBYY FineReader (see the description earlier in this 
list), it also has special hooks that let it receive scans directly and 
seamlessly from any Fujitsu ScanSnap scanner, with no special 
configuration required. 
(http://www.devon-technologies.com/products/devonthink/, 
$149.95) 

I think I can: To learn all about DEVONthink, including how to 
use it for OCR and general-purpose document management, read 
my book Take Control of Getting Started with DEVONthink 2. 

http://www.adobe.com/products/acrobat.html
http://irislinktest.iriscorporate.com/c2-1109-189/Cardiris-pro-4.aspx
http://irislinktest.iriscorporate.com/c2-1109-189/Cardiris-pro-4.aspx
http://www.devon-technologies.com/products/devonthink/
http://www.takecontrolbooks.com/devonthink-2?pt=INTERNAL
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• Evernote Premium: Evernote is the name of both an application 
(available for Mac OS X, Windows, and iOS, among other plat-
forms) and an accompanying cloud-based service that lets you save, 
search, and share documents of many kinds—from notes to photos 
to PDF files—on nearly any device. The applications, and the basic 
service, are free, but a paid service called Evernote Premium adds 
several options, including support for creating searchable PDFs 
from scanned images or digital photographs. The OCR conversion 
itself happens in the cloud. Currently, only English, Japanese, and 
Russian are supported, however. 
(http://www.evernote.com/about/premium/, $5 per month or $45 
per year) 

• ExactScan 2 Pro: This software recognizes text in 24 languages, 
although you can choose only one at a time. It offers a variety of 
ways to process scanned images, including automatic cropping and 
deskewing, deleting blank pages, and adjusting sharpness and con-
trast. It also supports AppleScript for automation. 
(http://www.exactscan.com/, $129) 

• NeatWorks for Mac: This software, which is bundled with the 
developer’s scanners (NeatDesk and NeatReceipts), is also available 
separately for those with other scanners. Its main claim to fame is 
that it can recognize the contents of business cards and receipts and 
store them in a searchable database, from which they can also be 
exported or synced in various ways. The software also provides 
document management for run-of-the-mill searchable PDFs. One 
downside, however: NeatWorks currently supports only English. 
(http://www.neatco.com/products/neatworks-for-mac, $79.95) 

• NewSoft Presto PageManager SE: PageManager is an oddly 
designed and rather un-Mac-like application, but it does get the job 
done, and includes a document manager that handles all kinds of 
scanned documents, including photos. It recognizes 13 languages, 
of which you can choose only one at a time. PageManager has no 
AppleScript support, and even basic usage requires you to switch 
between two or more applications.  
(http://www.newsoftinc.com/products/product-main.asp? 
productid=NAI0053, $69.95) 

http://www.evernote.com/about/premium/
http://www.exactscan.com/
http://www.neatco.com/products/neatworks-for-mac
http://www.newsoftinc.com/products/product-main.asp?productid=NAI0053
http://www.newsoftinc.com/products/product-main.asp?productid=NAI0053
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• OmniPage Pro X for Mac: OmniPage Pro has a wealth of fea-
tures commensurate with its price. It can recognize text in any of 
59 languages, although it supplies dictionaries and detailed analysis 
for only 13; you can specify one or more secondary languages in 
addition to a primary language. The software can run interactively 
(with tremendously fine-grained control over the results, and the 
capability to improve its accuracy based on your corrections) or 
automatically, and it supports AppleScript. You can optionally 
retain the original layout and save documents in editable formats. 
(http://www.nuance.com/for-business/by-product/omnipage/ 
mac/, $499.99) 

• OCRKit: This no-frills OCR software from the developer of 
ExactScan Pro 2 offers drag-and-drop conversion to searchable PDF 
from any common bitmap file format. It recognizes 12 languages, 
supports AppleScript, and is also available as an iPhone app. 
(http://ocrkit.com/, $49) 

• Paperless: Somewhat along the lines of NeatWorks, Mariner 
Software’s Paperless is a document management application that 
performs OCR on scanned documents, with special treatment for 
receipts and other financial records, which can be decoded and 
entered into a database—and exported for use with Quicken or 
spreadsheet applications, if you wish. Like DEVONthink Pro Office, 
it integrates directly with Fujitsu’s ScanSnap scanners. And, it 
includes an application called ScanHelper, which lets you easily 
route scanned documents to specific applications. Unfortunately, 
Paperless currently supports OCR only in English. 
(http://marinersoftware.com/paperless, $49.95) 

• PDF OCR X: This program offers easy, drag-and-drop conversion 
of scanned documents to searchable PDF. To recognize text in a lan-
guage other than English (of which 32 are available), you need only 
download and install a free language pack. A free version supports 
only single-page documents, while the paid version places no limits 
on document length. No AppleScript support is included, however. 
(http://solutions.weblite.ca/pdfocrx/, Community Version, free; 
Enterprise Version, $29.99) 

• PDFpen: When I need to make a quick edit to a PDF (such as 
superimposing a copy of my handwritten signature—see Sign 

http://www.nuance.com/for-business/by-product/omnipage/mac/
http://www.nuance.com/for-business/by-product/omnipage/mac/
http://ocrkit.com/
http://marinersoftware.com/paperless
http://solutions.weblite.ca/pdfocrx/
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Documents without Paper), I immediately turn to PDFpen, which 
makes this sort of activity simple. Among many other features, it 
also offers OCR in 12 languages and solid AppleScript support. 
(http://smilesoftware.com/PDFpen/, $59.95) 

• PDFpenPro: The Pro version of PDFpen has extra features—it 
can convert Web pages into multi-page PDFs, create PDF forms, 
and add a table of contents for easier navigation—but its OCR 
capabilities are the same as the less-expensive PDFpen. 
(http://www.smileonmymac.com/PDFpenPro/, $99.95) 

PDFpen made easy: For a thorough tour of PDFpen and 
PDFpen Pro, read Take Control of PDFpen 5. 

• Prizmo: What sets this OCR software apart from the rest is that it 
delivers good results from scanned documents and it offers unique 
features for processing photos of documents taken with digital 
cameras. Prizmo can correct problems like skewed perspective, lens 
distortion, and page curvature—and then perform OCR on the 
cleaned-up image. The result is more-accurate OCR plus a vastly 
improved underlying bitmap. Prizmo can recognize text in ten lan-
guages, too. Unfortunately, it has no AppleScript support and can’t 
be configured to process images automatically when they’re opened; 
manual interaction is required. At present, it doesn’t work with 
multi-page documents—each page must be processed separately. 
(http://www.creaceed.com/prizmo/mac/, $49.95) 

• Readiris Pro for Mac: Readiris is one of the more advanced 
OCR programs. It recognizes text in 125 languages, and it even 
supports mixed character sets in a single sentence; an Asian edition 
adds support for Hebrew (I know, not really an “Asian” language), 
traditional and simplified Chinese, Japanese, and Korean. The 
documentation emphasizes that although Readiris recognizes 
handprinting, it doesn’t recognize handwriting. Like OmniPage 
Pro, Readiris normally runs interactively and learns as you correct 
its errors, but you can convert documents to searchable PDF using 
drag-and-drop or—with a little help—with an AppleScript folder 
action (see Automate OCR). And, it can optionally save documents 
in an editable form that preserves the original layout. 
(http://www.irislink.com/c2-1685-189/Readiris-12-for-Mac.aspx, 
$129) 
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http://smilesoftware.com/PDFpen/
http://www.smileonmymac.com/PDFpenPro
http://www.takecontrolbooks.com/pdfpen-5?pt=INTERNAL
http://www.creaceed.com/prizmo/mac/
http://www.irislink.com/c2-1685-189/Readiris-12-for-Mac.aspx
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• VelOCRaptor: Barely edging out PDF OCR X as the least 
expensive of these packages, VelOCRaptor offers “no-click” drag-
and-drop conversion, and includes an Automator action to facilitate 
creating your own automated workflows. However, the developer 
notes that because it relies on the open-source OCRopus OCR 
engine, which is still incomplete, accuracy is lower than with 
competing applications. And, at present, it supports only English. 
(http://www.velocraptor.com/, $29) 

• VueScan: Although primarily designed to work with one-page-at-
a-time flatbed scanners, VueScan supports a huge number of scan-
ner models; has versions available for Mac OS X, Windows, and 
Linux; and lets you create searchable PDFs. The program contains 
built-in support for English, and you can download free files that 
add support for 32 additional languages. Unfortunately, VueScan 
offers no AppleScript support. 
(http://www.hamrick.com/, Standard edition, $39.95; Professional 
edition, $79.95) 

Joe’s OCR Software Recommendations 
Of the applications discussed in this chapter, I have experience with 
about half. All the Mac OCR tools I’ve tried have had acceptable 
accuracy, but some are easier to use than others. 

My personal preference is for a tool that works more or less invisibly 
behind the scenes. I like to configure things so that images from my 
scanner get the OCR treatment without interrupting my work or taking 
over my screen. A few of these applications—Presto PageManager, 
OmniPage, and Readiris—are what I think of as “old school,” in that 
their design assumes you’ll open the application, initiate a single-page 
scan from within it (typically, on a flatbed scanner), watch the OCR as 
it progresses, edit the final document, and then save it. There’s nothing 
wrong with any of that—and all three of those applications can be used 
in a much more automated, hands-off way—but I tend to gravitate 
toward applications with a more modern, minimalist aesthetic. 

I’ve been pleased with the results, interface, and flexibility of ABBYY 
FineReader—or at least the versions of it included with Fujitsu’s 
ScanSnap scanners and DEVONthink Pro Office. It’s reasonably fast, 

http://www.velocraptor.com/
http://www.hamrick.com/
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recognizes text in multiple languages without any fuss (I scan about 
equal amounts of English and French text), and requires no interaction 
under normal circumstances. I previously used Acrobat Pro along with 
an AppleScript folder action (see Automate OCR), which worked fine, 
except that limitations in Acrobat’s design prevented me from doing 
anything else with my Mac while scanning and processing documents. 

If you need an uncommon feature, you should go for one of the tools 
that offers it. Otherwise, if you’re looking for strictly OCR, I’d lean 
toward ABBYY FineReader. For PDF editing, I’d choose PDFpen over 
the much-more-expensive Acrobat Pro; if document management is 
your focus, I’d go with DEVONthink Pro Office; and if you particularly 
need to deal with receipts, I’d give a slight nod to Paperless. 
 
 

OCR for Sheet Music 
When I think about “business documents,” what normally comes 
to mind are pages full of text, tables, and graphics. But if your 
business happens to involve music, you may be interested to 
know that you can perform advanced OCR on sheet music, too! 
Specialized software can recognize notes and other musical sym-
bols, transforming a scanned sheet into a file readable by various 
popular notation and scoring applications—and even into a MIDI 
file that you can play back immediately. I’m currently aware of 
two Mac applications that can do this: 

• PhotoScore Ultimate: Besides performing OCR on printed 
music, this program can also read handwritten scores. 
(http://www.neuratron.com/photoscore.htm, $249) 

• SmartScore X: This OCR program also includes a full-featured 
musical notation editor. 
(http://www.musitek.com/X/, editions range in price from $49–
$399 depending on the combination of features you need) 

http://www.neuratron.com/photoscore.htm
http://www.musitek.com/X/
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Configure Your Software 
 
The best OCR software in the world can still produce lousy results if 
you don’t set it up just so and give it the best possible input material 
to work with. You’re looking for a combination of settings that gives 
you the best balance of OCR accuracy, processing speed, image 
quality, and file size. I help you figure out what those are in this 
chapter. I also show you several ways to automate scanning so that 
it takes as little manual effort as possible, and provide guidance 
about how to file your scanned documents so you can find and use 
them quickly in the future. 

Understand the Scanning Process 
The fact that your scanner includes OCR software, or that you’ve 
purchased such software separately, doesn’t necessarily mean that 
the process of creating a searchable PDF from a scanned document 
will be straightforward. It might be, but more often than not, it’s 
necessary to think through a multi-stage process, which may involve 
configuring the settings in two or more pieces of software. 

Every scanner comes with customized software that handles the low-
level communication between the scanner and your computer. For 
example, if you have a Fujitsu ScanSnap, the scanner-specific software 
is called ScanSnap Manager; with a Canon imageFORMULA scanner 
you’d use Canon CaptureOnTouch; with an Epson scanner it would be 
Epson Scan; and so on. This software is responsible for taking the raw 
data your scanner produces and turning it into a bitmap image stored 
on your hard disk. As a result, this software always provides some 
means of setting preferences such as resolution, destination, and file 
format. The scanner’s software may include many other capabilities, 
too, but for the moment, assume that its only purpose is to spit out a 
bitmap image, as shown in the top row of Figure 1. 

If you were scanning photos, then the bitmap image would be all you’d 
need. But for scanned documents, an additional step is generally nec-
essary (the bottom row in Figure 1)—another piece of software opens 
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the bitmap image, performs OCR on it, and generates a searchable 
PDF file. 

 
Figure 1: The typical path a document takes from scanner to 
searchable PDF. 

In short, it’s often necessary to work with two separate applications 
to end up with a searchable PDF. (And, if you want to use a document 
management program to catalog your scanned documents, you might 
end up working with three applications.) I emphasize this not only to 
avoid any confusion about what happens where but because I want to 
be crystal clear about your goal in scanning documents: 

What we’re trying to do: Produce searchable PDFs from paper 
documents with as little manual effort as possible—ideally, no more 
than a single button press. 

Since you want to avoid manual effort whenever you scan, you may 
feel some concern about the fact that two or more applications may 
be involved. Fortunately, the process has several potential shortcuts: 

• Some scanner software has built-in OCR capabilities, so you 
can skip the second application and go straight from scanner to 
searchable PDF without saving an intermediate bitmap file. Sim-
ilarly, some document management software can do OCR, so you 
can pass it a bitmap image and let it do the rest. 
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• Most scanner software gives you the option to send bitmaps directly 
to an OCR (or other) application, so even though the file is saved 
somewhere on disk in the process, you need not do anything with it 
yourself. 

• Most OCR and document management software can be configured 
such that as soon as it opens a document, it automatically performs 
OCR and saves your document as a searchable PDF. In other words, 
if your scanner’s software is set up to send a bitmap straight to your 
OCR software (as in the last point) and your OCR software is set 
up to recognize text and save the resulting document automatically, 
you get essentially the same end result as if OCR were built right 
into the scanner’s software—everything happens invisibly, in the 
background, without any intervention. 

• If your scanner’s software, OCR software, and/or document man-
agement software isn’t designed to facilitate this sort of automation, 
there may still be a way to coax it into behaving as though it did; I 
discuss this ahead, in Automate OCR. 

Now that you know where we’re going, your first step is to consult 
the documentation that came with your scanner and open whatever 
application is responsible for managing those low-level settings such 
as resolution and destination. In the next couple of topics, I give you 
some guidance as to how you should configure that software to end 
up with a bitmap image suitable for OCR, and to send that image (if 
possible) directly to the software that’ll handle the OCR process. 

Because space doesn’t permit me to give detailed instructions for every 
application, I illustrate most of the settings that follow with examples 
from Fujitsu’s ScanSnap Manager software. If you’re using software 
from another manufacturer, the options and wording will vary, but you 
should be able to find roughly comparable settings. 

Set the Resolution 
The first decision to make is the resolution at which your scanner 
will save images of your scanned documents. Every scanner mentioned 
in this book has an optical resolution of 600 dpi, so that’s the 
maximum—but they can all be set to scan at lower resolutions, too.  
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The choice of this single number has significant implications: 

• OCR accuracy: Up to a point, higher-resolution scans produce 
more-accurate OCR results. At very low resolutions, such as 75 dpi, 
there’s too little data to ensure good quality OCR, especially if the 
text is small. Surprisingly, though, it turns out that the relationship 
between resolution and accuracy isn’t linear—it starts to drop off 
after 300 dpi. That is, a 300-dpi scan could be twice as accurate 
as a 200-dpi scan, whereas a 600-dpi scan may offer only a tiny 
additional improvement. A very high resolution may even lead to 
lower accuracy, as dust, streaks, and other random marks are more 
likely to be misinterpreted as text. In my experience, the difference 
in accuracy over 300 dpi (assuming a black-and-white document) 
is usually miniscule—and indeed, most OCR software specifies 
300 dpi as the optimal input resolution. 

• File size: Higher resolution equals larger files. Depending on 
compression settings, a 600-dpi scan can produce files up to four 
times the size of a 300-dpi scan. For a single file, this difference 
may not be significant, but once you’ve scanned hundreds or thous-
ands of files, it can add up—and remember, all that data must be 
backed up, too. So, it’s logical to use the lowest resolution consistent 
with the desired results. 

• Processing speed: It takes longer for a document to travel 
through the scanner when being scanned at a higher resolution than 
at a lower resolution. In addition, when it comes time for your OCR 
software to work with the document, it’ll require more time, and 
more CPU power and RAM, to process a higher-resolution scan 
than a lower-resolution one. 

• Reprint fidelity: Higher-resolution scans are more accurate than 
lower-resolution scans, which means that if you should ever need 
to print a document that you’ve scanned, you’ll get clearer, crisper 
results with a higher resolution. The difference between printouts 
of a 300 dpi image and a 600 dpi image may not be readily appar-
ent to the naked eye except at very small font sizes, but documents 
scanned at, say, 150 dpi will look distinctly fuzzier and more pixel-
lated (think of faxes) than those at 300 dpi or higher. 

In short, in the vast majority of situations, 300 is the magic number—
at least for black-and-white documents. (For color or grayscale 
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documents, which have more data to work with per pixel, you can 
get away with somewhat lower numbers.) Go higher than that and 
you’ll get a big increase in file size and processing time but only a 
tiny increase in OCR accuracy and reprint fidelity. If you’re scanning 
documents with very fine lines or tiny text sizes, it’s worth bumping 
the resolution up a bit, but otherwise, stick with 300 dpi. 

Remember that this is the resolution at which the initial scanned 
image will be saved—before any OCR takes place. That means you 
must configure it in the scanner’s own software package. To illustrate 
with ScanSnap Manager, the Scanning tab (Figure 2) offers the 
following choices, with better-quality options resulting in slower scans: 

• Auto: Uses the “Better” setting except when scanning business 
cards, for which it switches to “Best” 

• Normal (Color/Gray: 150 dpi; B&W: 300 dpi) 

• Better (Color/Gray: 200 dpi; B&W: 400 dpi) 

• Best (Color/Gray: 300 dpi; B&W: 600 dpi) 

• Excellent (Color/Gray: 600 dpi; B&W: 1200 dpi2) 

Assuming that most of the documents you’ll scan are black-and-white, 
Normal or Auto settings are perfectly fine, but if you’ll be scanning lots 
of detailed color documents too or want a bit of a boost in quality with-
out increasing file size and processing time much, Better would be a 
good compromise. 

                                            
2 The ScanSnap’s optical resolution is only 600 dpi, but it can use a software trick 

called interpolation to simulate a higher resolution—in this case, 1200 dpi. 
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Figure 2: In ScanSnap Manager, choose a resolution from the 
Image Quality pop-up menu. 

Set the Destination 
The next choice you must make is the destination for the bitmap file. 
In general, you can choose either of the following: 

• Send it to an application. Not all scanner software lets you do 
this, but if it does, it’s a good choice, because it lets you hand the 
bitmap directly to your OCR software (or to a document manager 
that can do OCR) without any fuss or extra steps. Figure 3 shows 
the Application pop-up menu on ScanSnap Manager’s Application 
tab, configured to send scanned documents direct to DEVONthink 
Pro Office, which is in turn set up to do OCR automatically. (But, 
if you prefer, you could choose any OCR application here—or even 
Scan to Searchable PDF, which I discuss just ahead, in the sidebar 
ScanSnap Manager and OCR.) 
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Figure 3: In ScanSnap Manager, choose an application on the 
Application tab to send scanned documents directly to it. 

• Save it to a folder. Choose a folder on your disk—I suggest either 
~/Pictures or a subfolder you create there, such as ~/Pictures/ 
Scans—where all the raw bitmap files will be stored as your scanner 
generates them. Usually, even if you choose to send scans directly 
to an application, your scanner saves a copy of the bitmap file some-
where for future reference, so you’ll still need to set a location on 
your disk. In ScanSnap Manager, you do this on the Save tab. 

Along with selecting a destination folder, you usually have the 
option to specify a pattern used for naming files as they’re scanned. 
For example, in ScanSnap Manager, click the Options button on the 
Save tab to display the dialog shown in Figure 4, where you can 
choose a predefined format (based on the date and time) or create a 
pattern of your own. Once the document has gone through the OCR 
step, you’ll have an opportunity to name the searchable PDF, so I 
don’t place much importance on the names of the bitmap files. 
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Figure 4: Most scanner software lets you choose what format file-
names have when documents are first scanned. 

 

ScanSnap Manager and OCR 
If you have a Fujitsu ScanSnap scanner, you may notice that its 
software offers no fewer than three ways of performing OCR: 

• Scan to Searchable PDF: When you choose this command 
from the Application pop-up menu on the Application tab, 
ScanSnap Manager opens scanned documents in a separate 
application—a customized version of ABBYY FineReader—which 
then performs the OCR and is highly customizable. (Or, you can 
opt for Cardiris, which is better for processing business cards.) 

• Use another application: Choose another OCR-capable 
application from the Application pop-up menu—such as 
DEVONthink Pro Office or Acrobat Pro (which is bundled with 
some ScanSnap models)—and the file opens in that application. 

• Convert to Searchable PDF: On ScanSnap Manager’s File 
Option tab is a Convert to Searchable PDF checkbox. When 
it’s selected, OCR happens as you scan, without an external 
application launching. This option lets you do interesting things 
like scanning only sections you’ve marked with a highlighter, 
but on the whole it’s less flexible than the Scan to Searchable 
PDF option. Oddly, the software lets you select both methods—
which results in OCR happening twice on any given file! 

I discuss this further in “ScanSnap S1300 vs. Doxie: Two Portable 
Document Scanners” (http://db.tidbits.com/article/11458). 

http://db.tidbits.com/article/11458
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Your scanner software may offer more than just these two options 
(send scans to an application or save them to a file). For example, 
ScanSnap Manager lets you choose a feature called Quick Menu by 
selecting the Use Quick Menu checkbox at the top of the window. 
When you do this, every time you scan a document, a special window 
(the eponymous Quick Menu) pops up to let you choose what to do 
with that particular scan. This approach is useful if you do a variety 
of activities with scanned documents (for example, you print some, 
you email some, and you send still others to iPhoto). But since I almost 
always want to save my own scans as searchable PDFs, I leave this 
feature turned off most of the time. 

Set the File Format 
Your document will eventually end up as a PDF, but the bitmap image 
that your scanner produces initially could in theory be in any of several 
common formats, such as TIFF, JPEG, PNG, and (naturally) PDF. 
Most scanning software lets you choose the bitmap file format, 
although some offer more choices than others. 

Here are my recommendations, in order from most to least preferable: 

• PDF: Since you’re going to end up with a PDF anyway, this is the 
simplest choice. PDF documents can contain more than one page, 
unlike PNG and JPEG, so the PDF format is ideal for multipage 
scanned documents. It’s also wise because any application that 
can create searchable PDFs can also read PDF files, but some other 
formats can’t always be used as input. 

• TIFF: TIFF files can also contain multiple pages, and the format 
is widely supported. However, if your scanning software happens 
to save TIFF files in an uncompressed format, they can take up 
quite a bit of disk space. 

• PNG: This format is often used for graphics on the Web because 
it produces reasonably small files with lossless compression, which 
doesn’t degrade the quality or throw away any data. However, PNGs 
are limited to one page. 

• JPEG: The most common format for files created by digital cam-
eras, JPEG is universally supported. Unfortunately, although JPEG 
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files tend to be smaller than PNGs, they’re compressed in a way that 
decreases their intrinsic quality (and the effect is magnified each 
time they’re saved). Plus JPEGs, like PNGs, can have only one page. 

Set Other Scanning Options 
The list of other scanning options you may be able to set is long and 
highly variable. And, in general, whether or how to change any of these 
things is up to you—you might want to experiment and see what works 
best with your combination of scanner, software, and documents. 

Here and there: Many of these settings are also available in certain 
OCR applications; it’s up to you to decide where it makes the most 
sense to use them. 

Examples of other commonly seen settings: 

• Color mode: Black-and-white bitmaps take up very little disk 
space, while grayscale images take up more space, and color images 
still more. However, if colors or gray shades are essential for the 
documents you’re scanning (for example, ones that include photo-
graphs or artwork), you’ll want to set the appropriate color mode. 
If your scanner has an Auto setting that enables it to figure out the 
proper color mode as it scans, that’s even better! 

• Scanning sides: Most of the scanners I listed earlier in this ebook 
support duplex scanning (both sides of the page at once), and if 
you’re scanning double-sided documents, you’ll obviously want 
duplex scanning enabled in your software. However, in some 
cases—for example, when scanning documents that have graphical 
patterns, but no text, on the reverse—you may want to turn off 
duplex scanning so you don’t waste disk space with lots of useless, 
effectively blank pages. 

• Automatic blank page removal: If your software is set for 
duplex scans but some of the pages you feed into your scanner are 
completely blank on one side, you may want to have those empty 
pages removed from the resulting PDFs automatically—if so, turn 
on this feature. 
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• Brightness and/or contrast: In most cases, you can leave 
brightness and contrast controls at their default settings. However, 
if you’re scanning documents on colored papers or with very light 
text and find that the image quality, OCR accuracy, or both are 
substandard, you might be able to improve your results by playing 
with brightness and contrast settings. 

• Deskewing: If you feed a page into your scanner at a slight angle—
or if the paper is straight but the text on the page is at an angle—
some scanner software can straighten it for you, within reason. 

• Automatic image rotation: With this feature, it doesn’t matter 
whether you feed documents into the scanner upside-down or 
sideways; the software automatically rotates the resulting images 
to be right-side-up. 

• Paper size: Most scanners can automatically figure out the size 
of the paper you feed into them, and produce bitmap images of the 
same size. However, you can often choose an arbitrary paper size, 
too—for example, if you want all your PDFs to be letter-sized, even 
if you’re scanning smaller pieces of paper. 

• Compression: Even if you chose PDF as the file format, the bit-
maps inside the PDFs can often be compressed to reduce the file 
size, especially if the scan was done in color or grayscale. Higher 
compression equals smaller files, but depending on your scanner’s 
software, it might also reduce the image quality, which can in turn 
reduce OCR accuracy. 

• Multipage documents: Let’s say you put a stack of 15 pages in 
your scanner’s ADF and push the button. Do you expect to get a 
single 15-page PDF, or 15 single-page PDFs, or something else? You 
may be able to specify how your scanner’s software treats multipage 
documents—for example, always combining continuous scans into 
a single file, or automatically splitting the file every five pages. 

Set OCR Options 
That should do it for your scanner’s software. But if you’re using a 
separate application for OCR, as is true more often than not, you 
should next open that application and take a quick spin through its 
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preferences. They’re likely to be less involved (and may include some 
of the same options described just previously), but at minimum, be 
sure you configure the following: 

• Language: Since you’re reading this ebook in English, I’m 
guessing you’ll choose English as the primary language for your 
scans. But, if the documents you scan sometimes contain other 
languages, you may need to adjust the language setting. Most OCR 
software lets you select one or more secondary languages (and then 
it automatically uses the correct dictionary and rules as it encoun-
ters each one), but remember that the more languages you add, 
the longer it will take to process each file—and the greater the 
probability that the software will guess wrong from time to time 
and produce unintelligible results. 

• Output format: As you know by now, the right choice here is 
nearly always searchable PDF. However, if your software offers 
the choice, you may occasionally find that saving in formats such 
as Microsoft Word or Excel produces more-usable documents. 

• Output destination: If the application performing OCR is a 
document manager, then the destination for the searchable PDFs 
is that application itself. Otherwise, choose a folder on your hard 
disk (presumably inside ~/Documents) or on a network volume. 
(If you need help deciding where to store the documents, read 
Choose a Naming and Filing Strategy, next.) 

• Output file name: Depending on the OCR software you use and 
how, if at all, you automate it (as I discuss later, in Automate OCR), 
it may resave the document under the same name the bitmap image 
had originally, or it may give you the option to respond to a prompt 
to rename it on the spot. I say more about this choice next. 

The settings for those last two items—destination and file name—may 
be obvious to you, or they may require more thought. And, if you’ll be 
sharing scanned files with others, some additional questions may arise. 
So before you finalize your settings, read the next section for advice on 
naming and filing your scans. 
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Choose a Naming and Filing Strategy 
Naming your searchable PDFs and filing them (that is, storing them 
in some particular location) may be entirely separate activities, but it 
usually makes sense to do them together. And, your OCR software may 
expect you to make decisions up front about how these tasks will be 
handled. So it’s a good idea to think through your options carefully. 

Fundamentally, you have four questions to answer: 

• When do you want to name and file the documents? That is, 
do you want to name them as you scan them, or at some later time? 
I cover this below, in “Decide When to Name and File Documents.” 

• What do you want to name the documents? You can choose 
any name you like, but for ease of finding documents later (especi-
ally if others will use them too), you should think about what con-
ventions you’ll use. Read Choose a Naming Convention. 

• How do you want to retrieve the documents? By “how” I 
mean: store them as regular, stand-alone documents that you’ll find 
and retrieve using the Finder—or store them in the database of a 
document management program? See Choose a Retrieval Method. 

• Where do you want to store the documents? Will you keep 
them on your local hard disk, on a network server, in the cloud, or 
in some combination of these places? Read Choose a Destination. 

 

Decide When to Name and File Documents 
As you perform OCR on your scanned documents, you have three basic 
choices as to what happens next: 

• You can be completely “hands off” and let your software name and 
file the documents automatically. 

• You can intervene immediately by giving your documents names 
(and sometimes tags or categories) and putting them in specific 
locations. 

• You can name and file your scanned documents later, at your 
leisure. 
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I can think of good reasons for choosing any of these approaches, but 
the important thing is to weigh the pros and cons, decide how you 
want to handle the process, and stick with it. 

Use the Hands-Off Approach 
The appeal of the entirely hands-off approach is obvious: it requires no 
effort other than pressing a button. So, if you’re concerned that you’ll 
never get around to scanning otherwise, that’s a significant positive. 

On the negative side, if you let your software name scanned docu-
ments, the names (usually a string of numbers based on the date and 
time) won’t be meaningful to you, and when it comes time to find a file, 
you won’t be able to distinguish one from another by name; you’ll have 
to examine their contents too. 

And, if you let your software file the documents too, they’ll almost cer-
tainly end up in a single big folder somewhere, which again makes it 
harder to find what you’re looking for later on. 

Tip: DEVONthink Pro Office’s Auto Classify feature can sort 
scanned documents into folder-like groups automatically based 
on their contents, mitigating this problem somewhat. 

For me, since I’m scanning documents in order to make my life easier, 
the negatives of the hands-off approach outweigh the positives. 

Name and File as You Go 
You can choose to name every document as soon as your OCR software 
turns it into a searchable PDF. At the same time, you can optionally file 
it in an appropriate folder and, if you’re using a document manager 
that supports tags, apply tags that will help you identify the document 
later. 

The big advantage to doing this is that you’ll make it much quicker 
to find the document later—and by doing this work right away, the 
subject matter of the document will be fresh in your mind, making 
naming easier. 

The disadvantage is that it’s not merely more work, it turns scanning 
into a task that demands your ongoing attention, because you have to 
stop after every document goes through the scanner, think about it, 
and perform one or more extra steps. 
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Name and File after the Fact 
As a compromise between the first two options, you can let your 
computer process everything automatically at first, but then later on—
say, once a week—go back and review recently scanned documents, 
name them, file them in the proper locations, tag them, and so on. 

Although this approach gives you the benefits of both the other alter-
natives, it has a downside, too: it’s more time-consuming to identify 
and name documents after the fact than right away. And, if you let it go 
too long, the task might become so overwhelming that you never do it. 

Nevertheless, this is what I do myself most of the time. I’m disciplined 
enough to avoid letting my unnamed scans pile up for months, and 
sometimes I’m even inspired enough to name files as I go. 

Choose a Retrieval Method 
After OCR is complete (whether or not you’ve taken the time to choose 
a name) and you have a searchable PDF, you can leave it in the folder 
where it started—the one where the bitmap images straight from the 
scanner live—or you could move it somewhere else. I’m a proponent 
of the “somewhere else” approach myself, but before you can decide 
where, exactly, to store your files, you need to know what technique 
you’ll use to find and view your PDFs later. In particular, you need 
to decide whether you are going to store the PDF as an ordinary file 
in the Finder—and if so, where? Or, are you going to use a document 
manager to store everything? 

Use the Finder 
The default way to retrieve documents is to find and open them in 
the Finder, possibly with the help of Spotlight. Storing PDFs in regular 
Finder-accessible folders is easy—and it’s what happens automatically 
if you don’t take any other action, and Spotlight automatically indexes 
the documents. Because the PDFs are now ordinary, searchable files, 
you can organize them just like all your other documents—for example, 
if you scanned documents relating to a specific project, they might go 
in that project’s folder in the Finder; or if your scans are of utility bills, 
they might go in a folder with other financial documents. Or, you may 
choose to keep all your searchable PDFs, regardless of contents, 
together in one place. 
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Before you choose Spotlight and the Finder as your retrieval tools, 
spend a moment pondering these questions: 

• Do you like Spotlight? Some people love Spotlight; some 
hate it. But if the point of creating searchable PDFs is to make 
them, you know, searchable, then you should keep in mind what 
you’ll be using to search them.  

If Spotlight works well for you, then the Finder is a great 
destination. If it doesn’t, consider a Spotlight enhancement such 
as HoudahSpot (http://www.houdah.com/houdahSpot/, $30), 
an alternative search engine such as Google Quick Search Box 
(http://www.google.com/quicksearchbox/, free) or FoxTrot 
(http://www.ctmdev.com/foxtrot/; Professional, $132; Personal, 
$39), or a document manager (covered next). 

• Do you need to share these files? If you’re scanning strictly 
personal documents, then you can store them wherever you want. 
But if a colleague or family member will need to use them too, then 
you must do two things: 

◊ Agree on conventions for naming and organizing them. 
This can sometimes be a source of contention—but I return to 
this issue shortly ahead, in Choose a Naming Convention. 

◊ Store them in a network-accessible location. This could 
be a shared folder on your Mac, a network volume, or shared 
cloud-based storage. I say more about this in Choose a 
Destination. 

• Would you like other categorization tools? The Finder offers 
only strictly hierarchical filing (although you can create aliases to 
give yourself pointers to files in other locations). If you’re wired to 
work more efficiently with a different categorizing scheme, such as 
tags—or if a lot of the documents you scan require accompanying 
database entries (for things like receipts and business cards), keep 
reading to learn about document managers. 

Tip: If you’re undecided, you can always use the Finder initially 
and move to a document manager later if you need more power. 

http://www.houdah.com/houdahSpot/
http://www.google.com/quicksearchbox/
http://www.ctmdev.com/foxtrot/
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Use a Document Manager 
I mentioned several document managers in the discussion of OCR 
software (Pick a Mac OCR Package). Essentially, they’re applications 
that provide their own storage space, categorization, display, and 
search methods for files and other snippets of data. You might prefer 
one of these over storing files in the Finder for any number of reasons, 
such as a more pleasant user interface, more-flexible (or faster) 
searching, support for tags, or other database features. 

The document managers I covered earlier all have built-in OCR 
capabilities, and two of them (NeatWorks and Paperless) are specially 
designed to work with structured data such as receipts. And, I’ve men-
tioned that I’m personally a fan of DEVONthink Pro Office. However, 
a few other options are also worth considering, as long as you have 
some independent way to perform OCR: 

• DEVONthink Personal (http://www.devontechnologies.com/ 
products/devonthink/, $49.95) 

• DEVONthink Professional (http://www.devontechnologies.com/ 
products/devonthink/, $79.95) 

• EagleFiler (http://c-command.com/eaglefiler/, $40) 

• Yojimbo (http://www.barebones.com/products/yojimbo/, $39) 

If you’re considering one of these applications, I suggest downloading 
a demo version and making sure you can find a way (such as using an 
AppleScript folder action) to store your searchable PDFs directly in the 
document manager of your choice. 

Tip: If you use an iOS device, you might look for a document 
manager that has a companion iOS app—DEVONthink Pro Office 
and Yojimbo do, for example.  

Document managers normally use your local hard disk as the storage 
destination for their databases. It may be possible to choose a network 
volume instead, but that in itself doesn’t guarantee that other people 
can access the data there. For other people to access the contents of 
your document manager’s database, it must offer some sort of sharing 
mechanism—for example, a built-in Web server, as DEVONthink Pro 

http://www.devontechnologies.com/products/devonthink/
http://www.devontechnologies.com/products/devonthink/
http://www.devontechnologies.com/products/devonthink/
http://www.devontechnologies.com/products/devonthink/
http://c-command.com/eaglefiler/
http://www.barebones.com/products/yojimbo/
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Office does. Be sure to consider sharing capabilities as you’re 
evaluating demonstration versions of document managers. 

Choose a Naming Convention 
I don’t want to belabor this point, nor can I provide any universal 
solutions, but it’s worth giving some thought to what you’ll name your 
searchable PDFs so you can more easily find them later—and so any-
one else who needs to use the files can clue into their contents. (If 
you’re content with file names like “2010_10_22_09_35_25.pdf,” then 
feel free to skip ahead to the next section!) 

Suppose you’re scanning a stack of invoices. Naming them all 
“invoice.pdf” may be a bit better than nothing, but then, when you 
search for one of these and the result is a list of 100 files named 
“invoice.pdf,” you won’t know which is which without examining each 
one individually. On the other hand, although nothing prevents you 
from naming a file “Invoice #416, dated November 1, 2010, from ABC 
Supply Corp for $432.19.pdf,” that’s cumbersome to type and equally 
awkward to read. So, let me offer a few suggestions: 

• Think about how you’ll search. The entire contents of your 
OCR-processed PDFs will be searchable, but results will invariably 
appear in a list of file names—so if those names don’t make it 
obvious what’s unique about each document, you’ll have to look 
at each one in turn. In other words, do yourself a favor and put 
uniquely identifying words in the file names. 

• Don’t rely on folder names. Along the same lines, some people 
rely on a series of embedded folders to help them identify files. For 
example: Banks/Citibank/statements/2010/August.pdf. As long as 
you’re looking at a file in a hierarchical view in the Finder, that’s 
fine, but if you do a search that lists 20 files all named “August.pdf,” 
it’ll require extra work to figure out which one you want. It’s better 
to include extra detail in the file name, even if it seems redundant. 

• Combine generic with specific. Giving a file a generic name 
such as “bill.pdf” or “electricity.pdf” will only lead to frustration 
when you try to find it. But, “Electricity bill December 2010.pdf” 
adds a specific piece of information that uniquely identifies the file, 
and will come in handy later. 
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Consider the recipient: When you’re naming files that other 
people will be using—for example, invoices you’re sending to 
another company—think about what sort of name would be most 
useful on the other end. For example, if I send TidBITS an invoice 
named “TidBITS invoice—2010-10.pdf,” that’s meaningful to me 
but not to them. They already know who they are, but they won’t 
be able to tell, just by looking at the file name, that it came from 
me. Something that includes both names, like “Kissell invoice—
TidBITS—2010-10.pdf” meets both of our needs. 

• Write dates in a Finder-sortable way. The Finder automat-
ically identifies the date on which each document was created, but 
that’s the date the digital version was created—not necessarily the 
date of the paper original (which is almost certainly what you want 
to know). So it’s a good idea to include documents’ dates in their 
names, and I suggest using this format: YYYY-MM-DD (as in 2010-
09-30). That’s because files beginning with strings like that (or 
including them in a consistent place—for instance, “TidBITS invoice 
YYYY-MM-DD.pdf”) will always sort in chronological order in the 
Finder’s Column view, as well as in List and Icon view when sorted 
by name. (Using this format can come in handy even if you use a 
document manager, depending on its native sorting capabilities.) 

• Talk to your associates. It’s rare that two people would, on 
their own, come up with exactly the same scheme for naming files, 
but if you plan to share files with others, you should at least reach 
a consensus on what sorts of names everyone can live with. Or, 
simply designate one person as the Boss and let him or her decree 
a convention that everyone else consents to follow, even if it’s not 
their favorite. 

Choose a Destination 
If you’re storing searchable PDFs as ordinary, Finder-accessible files 
rather than using a document manager, make sure you put those files 
in a location that makes sense for your needs. Here are your options: 

• On your own Mac. If the files will be for your personal use 
only, then a location on your own hard disk (likely somewhere in 
~/Documents) is logical. If you want to use Mac OS X’s built-in file 
sharing feature to make the documents available to someone else, 
put them in a folder whose entire contents you’re willing to share. 
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Sharing details: For complete information about the ins and 
outs of file sharing, consult Glenn Fleishman’s Take Control of 
Sharing Files in Snow Leopard. 

• On a network server. For sharing scanned documents with a 
larger number of people in a business, a network server may be 
a more logical location, since it doesn’t depend on your own Mac 
being on, awake, and available on the network all the time. 

• In the cloud. You may choose a destination in the cloud, as 
discussed in Local vs. Cloud Storage, to be able to access your docu-
ments from any computer, and share them easily with people not 
on your local network. When considering one of these services, be 
sure to choose one that lets you mount your cloud storage space as a 
volume in the Finder (most do) so that you don’t have to go through 
a special procedure, or open another application, to upload the files. 

• Some combination of the above. As I said earlier, I recommend 
using cloud storage as a secondary location; it’s essential to have a 
copy of your data on a local (or local network) volume too. Luckily, 
it’s possible to do this automatically. For example, if you’re using 
Dropbox as your cloud storage provider, it automatically syncs files 
stored in a local folder (the eponymous Dropbox). If you’re using 
your MobileMe iDisk and have it synced to your Mac (you can set 
this up in the MobileMe pane of System Preferences, in the iDisk 
view), much the same thing happens. Other cloud storage services 
also let you sync local and cloud-based copies in various ways. 

http://www.takecontrolbooks.com/snow-leopard-sharing?pt=INTERNAL
http://www.takecontrolbooks.com/snow-leopard-sharing?pt=INTERNAL
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What about the Originals? 
Your scanner software puts a bitmap file in a folder somewhere, 
and your OCR software converts it to a searchable PDF—possibly 
storing it in a document manager as well. So, what happens to 
that original, non-searchable bitmap image? Depending on your 
software and settings, it could be any of the following: 

• Replace with searchable PDF. If your bitmap image is saved 
in PDF format (as I recommend), your OCR software might 
simply overwrite the bitmap-only version of the file with a 
searchable version having the same name. 

• Delete the original. Your OCR software may delete the 
original bitmap file after creating the searchable PDF—or you 
may do so manually, or using a script you devise. 

• Archive the original. Your OCR software (or a script you 
create) could move the original bitmap image somewhere else, 
just in case you later need it for some reason, but leaving your 
incoming scans folder uncluttered. 

All these are valid choices, depending on your needs, but I want 
you to be aware of the possibilities and determine, or decide, what 
happens on your own system to avoid surprises in the future 
(such as looking for an original you assumed you had, but finding 
it was deleted). My personal preference is to set my OCR soft-
ware’s preferences to delete the original, which seems tidiest—or 
perhaps I just like living dangerously. 

Automate OCR 
Earlier in this chapter, one of the options I described was routing 
incoming scans directly to an OCR program or feature, which (if you’re 
lucky) then creates searchable PDFs automatically. If that’s what hap-

pens on your Mac, congratulations—you can skip this section. 

But if your scanner’s software doesn’t support that configuration, or 
if you want to use OCR software that doesn’t automatically generate a 
searchable PDF when it opens a document, read on for instructions on 
automating the process. 
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Any scanner can save bitmap files into a folder somewhere on your 
disk, so that’s our starting point. Fundamentally, you need to make 
both of the following tasks happen automatically: 

• Your OCR software opens bitmap files as they appear in the folder 
where your scanner software saves them. 

• Your OCR software recognizes the text in the open bitmap file, and 
then saves the result as a searchable PDF. 

Luckily, you can often use the same tool to accomplish both tasks: 
an AppleScript folder action. For those who are unfamiliar with the 
concept, a folder action is an AppleScript that runs automatically 
when something happens to a specified folder—for example, you open 
or close it, or add files to it. So, the basic idea is this: Create a folder 
action script and attach it to the folder where incoming scans are 
stored so that it watches for new files being added; have the script 
open those files in your OCR program and then instruct your OCR 
program to go ahead and process the files. 

What’s particularly cool about this method is that often (not always) 
it can even automate OCR in applications that don’t inherently support 
AppleScript—or don’t support it in a robust way. This is possible 
due to a feature called GUI Scripting, which means that instead of 
AppleScript issuing a direct command to an application to perform 
some action, it instead simulates the user actions of choosing menu 
commands, clicking buttons, filling in fields, and suchlike. Unfortun-
ately, this means the application must be left alone to operate in the 
foreground—for example, if you were to switch to another window 
while this was going on, the AppleScript would no longer be able to 
“see” and operate the necessary controls. Still, it’s way better than 
having to go through the entire process manually every time. 

I’d like to offer you prewritten AppleScripts for every OCR program 
and with every possible combination of settings and behaviors, but life 
is too short. So, instead, I’m providing four scripts that can drive some 
of the most popular OCR tools, and at the same time serve as examples 
on which you can base your own scripts for other applications. You can 
also, of course, modify any of my scripts to make it work differently 
according to your needs. 
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Download the scripts from http://www.takecontrolbooks.com/ 
resources/0111/paperless_office_scripts.zip. After unzipping them, 
move the script files into /Library/Scripts/Folder Action Scripts; if 
that folder doesn’t exist, create it. (Be sure not to put the scripts in the 
similarly named Folder Actions folder, which may appear in the same 
location.) Then proceed with the instructions that follow to configure 
the scripts on your Mac. 

Help me help you: In order for GUI scripting to work with my 
scripts for Acrobat Pro and Readiris, you must enable access for 
assistive devices. To do so, open the Universal Access pane of System 
Preferences and make sure Enable Access for Assistive Devices 
is selected at the bottom of the window. But if you forget, it’s no 
problem—the scripts are smart enough to check for this setting and 
alert you if it’s incorrect. 

Enable and Attach Folder Actions 
Before you can use folder action scripts, you must enable the system-
wide Folder Actions capability if you haven’t previously done so, and 
attach a particular script to the folder where your incoming scans are 
stored. Follow the steps appropriate for the version of Mac OS X you’re 
running: 

Snow Leopard (10.6): 
1. Right-click (Control-click) on the folder where your scanner stores 

new scans (see Set the Destination, earlier in this chapter), and 
from the contextual menu that appears, choose Services > Folder 
Actions Setup. Folder Actions Setup opens. 

2. In the dialog that appears automatically, select the script you want 
to use (for example, “OCR This (PDFpen & PDFpenPro)”) and click 
Attach. 

One at a time: Although you can attach multiple AppleScripts to 
a single folder, I don’t recommend it. Pick a single script, and if 
need be, you can return here and change it later. 

3. Make sure Enable Folder Actions is checked at the top of the Folder 
Actions Setup window. Your window should look something like 
Figure 5. 

http://www.takecontrolbooks.com/resources/0111/paperless_office_scripts.zip
http://www.takecontrolbooks.com/resources/0111/paperless_office_scripts.zip
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Figure 5: You’re looking for approximately this end result (folder 
and script names may differ) after configuring Folder Actions. 

4. Quit Folder Actions Setup. 

Leopard (10.5): 
1. Right-click (Control-click) on the folder where your scanner stores 

new scans (see Set the Destination, earlier in this chapter), and 
from the contextual menu that appears, choose More > Enable 
Folder Actions. 

2. Right-click (Control-click) the same folder again and choose More > 
Attach A Folder Action. 

3. In the window that appears, navigate to the script you want to 
attach (remember, it’s in /Library/Scripts/Folder Action Scripts), 
select it, and click Choose. 

4. Close the window. 

Use a Folder Action Script 
You’re almost ready to go, but it’s best to tweak a setting or two for 
optimal behavior in your OCR application of choice, and to understand 
exactly what to expect of the scripts. 

Acrobat Scripts 
Acrobat Pro requires a slightly odd procedure to prepare it for OCR: 

1. Open a PDF file (any file at all). 

2. Choose Document > OCR Text Recognition > Recognize Text Using 
OCR. (In older versions of Acrobat Pro, and in Acrobat Standard, 
this command may appear as Document > Recognize Text Using 
OCR > Start.) 
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3. Click Edit. In the dialog that appears, make sure English (US) 
is chosen in the Primary OCR Language pop-up menu. Choose 
Searchable Image (Exact) from the PDF Output Style pop-up 
menu (although read Pick a Mac OCR Package for information 
on the ClearScan option). 

4. Click OK to close the Settings dialog, and then click Cancel (yes, 
Cancel) to dismiss the Recognize Text dialog. 

5. Close the PDF file you opened in Step 1. 

Now you’re ready to try out your script—either by scanning a docu-
ment or by dragging an existing scanned image into the folder to which 
the AppleScript is attached. I provide two different Acrobat scripts. 
Both work with Acrobat Standard version 7 and Acrobat Pro versions 
7, 8, and 9, but they have slightly different behaviors: 

• OCR This (Acrobat): This script causes Acrobat to recognize 
the text in PDF documents and then save the file (with the existing 
name, in the existing location) and close it with no need for inter-
action at all. 

• OCR This (Acrobat) with Save As: This script causes Acrobat 
to recognize the text and then prompt you to enter a name and 
select a location; after saving the file, the script then instructs 
Acrobat to close the window. (There may be a very brief delay 
before the window closes.) With this script, the original file remains 
in the folder to which you’ve attached the folder action; you can 
later delete it manually if you wish. 

PDFpen Script 
The OCR This (PDFpen & PDFpenPro) script works with either version 
of the PDFpen software (version 5 or later), without requiring any 
modification. However, for best results I suggest making one small 
change in PDFpen’s settings before using the script: 

1. Choose either PDFpen > Preferences or PDFpenPro > Preferences. 

2. Click OCR. 

3. Uncheck the Prompt for OCR When Opening a Scanned Document 
checkbox. 
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This may seem counterintuitive, but if you leave that checked, then 
whenever the script runs automatically on a newly scanned document, 
PDFpen will display a dialog asking if you want to perform OCR on it. 
That isn’t actually a problem—the script still works—but there’ll be a 
delay of a few seconds, and that dialog (and the beep that sounds when 
it appears) may be confusing and distracting. 

Once PDFpen is configured, scan a document (or drop an already-
scanned document into your designated scans folder) to try the script. 

Readiris Pro Script 
Before using the OCR This (Readiris) script, open Readiris Pro and set 

it up as follows: 

1. Look in the Settings > Document Type menu and make sure Text is 
checked; if it isn’t, select it. 

2. Choose Settings > Text Format. 

3. From the Format pop-up menu at the top of the window, choose 
PDF. From the pop-up menu next to it, choose Image-Text. 

4. Uncheck the Embed Fonts and Create Bookmarks checkboxes if 
they’re checked. 

5. Make sure the Ask File Name and Location checkbox is checked. 

6. Leave the other settings in this dialog as they are, and click OK. 

7. Choose Settings > Save as Default. (That way, these settings should 
stick when you use Readiris Pro again.) 

When a new PDF file appears in the folder to which you’ve attached 
the script, Readiris opens the file, recognizes the text in it, and saves 
it as a PDF; it prompts you to enter a name and select a location. 
(Unfortunately, because of Readiris Pro’s poor AppleScript support, I 
was unable to find a good way to avoid this need for interaction.) After 
you save the file, Readiris creates a new document (which clears all the 
existing scanned pages from its list). 
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Start with a clean slate: If you happened to have any pages open 
in Readiris Pro before running a script, the script will close them (so 
as to avoid adding extra pages to your PDFs). Therefore, before doing 
any scanning, make sure you’ve saved anything you were previously 
working on. 

Extend Folder Action Scripts 
The scripts I’ve provided are all fairly simple, but depending on your 
needs, preferences, and willingness to tinker with AppleScript, you 
could enhance them to do other things. Here are a few ideas: 

• Prompt you to name each PDF (if the script doesn’t already do so). 

• Save the searchable PDF to a different folder—for example, a 
network volume—and delete the original bitmap. 

• Send the PDF to a colleague by email. 

• Use one of Mac OS X’s built-in Services to summarize the text. 

• Use an online translation tool to translate the text into another 
language. 

• Speak the recognized text out loud using text-to-speech. 



80 

Create a Workflow 
for Incoming Paper 
 
Your scanner and software is now set up to process whatever you 
throw at it. And, you’ve already thought about at least some ele-
ments of your workflow, such as what you’ll name your searchable 
PDFs and where you’ll store them. But to make your life even easier, 
you should take a moment to think through the physical path papers 
will take from the time they enter your office to the time they leave 
it (or get filed)—and how you’ll find and use their contents once the 
originals are gone. This is the crux of the paperless office: the new 
workflow you’ll follow, which will require you to adopt or modify 
some habits. 

In this chapter I make sure you have a grip on the strategy for what 
you’ll actually do when paper appears, and that you understand 
when and why to keep certain papers—and what you can dispose of. 

Create a Physical Paper Path 
If you’re an extremely organized, “everything-in-its-place” kind of 
person, what I’m about to say may seem obvious. But I’ve known few 
people who keep every piece of paper strictly under control, and many 
(including myself) who always seem to have papers piled everywhere 
and, as a result, at least occasionally lose track of what’s where, and 
what needs to happen to which papers. Since you’re about to embark 
on a new system for dealing with papers, this is an excellent opportu-
nity to figure out, definitively, what happens to all papers as soon as 
they come into your possession.  

Thus, I want to propose the following Life Principle: 

Have a well-defined location for every stage of a paper’s journey. 

Let me explain what I mean and how you can make this happen. 
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Buy Some Boxes 
I’m going to ask you to acquire at least two boxes, and maybe as many 
as six or eight (I’ll explain why in a moment). When I say “box,” I don’t 
care if it’s an actual box, a plastic or metal tray, a wall-mounted paper 
holder, a file folder, or a taped-off corner of your desk. However you 
want to think of a box, make sure you can clearly designate multiple 
geographical areas of at least 8.5 x 11 x 2 inches each to special uses, 
which I’m about to describe. 

Think about the traditional idea of an In box and an Out box—that is, 
two trays sitting on your desk, one for incoming correspondence and 
one for outgoing correspondence. This arrangement (which I confess 
I’ve never seen anyone use in real life) presumes that your In box is, 
in some sense, your to do list, and that someone else—perhaps a 
mailroom employee—is responsible for putting things there. You’ll 
work your way through each item in that tray—reading it and then 
doing whatever is required, whether that’s writing a reply, filing it, 
making a phone call, or something else. Replies to incoming mail, 
along with new mail you generate from scratch, go into the Out box, 
where they’re picked up periodically by the same person who puts 
things in your In box. 

Now suppose you have an In box that you’ve designated solely for 
papers that will need to be scanned, and an Out box that’s solely for 
papers that have already been scanned. Your setup looks like this: 

 

In other words, you take something out of the In box, scan it, and as 
soon as it comes out of the scanner, it goes into the Out box. The path 
the paper follows is simple, obvious, and unambiguous. All you have 
to do is get in the habit of working through the contents of the In box 
regularly—we’ll return to that in a moment—and then periodically 
emptying the Out box by filing, recycling, mailing, or otherwise 
disposing of its contents. 

Such a setup may be adequate for people who receive relatively few 
pieces of paper and who are disciplined enough to move things from 
In, through the scanner, to Out, quite often. However, more complex 
needs may require some refinement. 

In Scanner Out
\\ 
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In Boxes 
Imagine you receive ten pieces of paper on a certain day, all of which 
have to be scanned. Great—they all go in your In box. However, sup-
pose those papers include a bill that absolutely must be paid by the 
end of the week, a newsletter that needs no particular attention any 
time soon, and some envelopes whose contents may or may not be 
important, but which you haven’t gotten around to opening yet. You 
can see how this might be a problem: put them all in the same pile, and 
you might lose track of whatever’s on the bottom—especially if the pile 
grows more quickly than you can process it. 

So, instead of a single In box, you might refine your paper path to 
include two or even three In boxes. For example, one only for 
unopened mail, one for opened items that require urgent attention 
(invoices, contracts, jury summons), and another for things that you 
can scan at your leisure. Your setup may then look more like this: 

 
And that way, your stress level is reduced because you know you need 
to pay strict attention to Urgent but don’t need to sweat Whenever, no 
matter how high the pile gets. 

Out Boxes 
The same is true on the other side. Maybe a simple Out box won’t cut 
it for you, because some of the things that go there have to be mailed 
right away, while others can be filed, shredded, recycled, or thrown 
out the window. (Later in this chapter, I discuss the important matter 
of which documents you should save; see Keep Legally Important 
Documents.) No problem; you can expand on the basic idea like so: 

 

I think that five Out boxes is overkill, but perhaps your paper shredder, 
recycling bin, and window happen to sit beside your scanner, so those 
don’t need to be boxes as such, and all you need are two: File and Mail. 

Scanner Recycle 
File 
Shred 

Mail 
Defenestrate 

In 

Unopened 
Urgent 

Whenever 
Scanner Out

\\ 
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However many boxes you decide on, and whatever you name them, 
the point remains that you should be just as clear about what happens 
to papers after they’ve been scanned as you are about the disposition 
of incoming papers before they’ve been scanned. 

Now go get yourself some boxes! 

Choose a Procedure 
Astute readers may have noticed an ambiguity in the In/Out box 
system I just described. Suppose you receive a bill, which goes in an 
In box. You scan it, and then the original goes into Out (or into the 
shredder or the recycling bin, or whatever). That’s all fine, but at what 
point in the process do you actually pay the bill? The same question 
could be asked about any incoming document that requires you to do 
something—make a phone call, sign a form, respond to an invitation. 
When do you do that something? Is it before you scan, or after? 

This question is not as trivial as it may sound. Consider: 

• If you scan a document before dealing with it, then the document 
will be digitized, perhaps giving you access to useful text that can, 
in fact, help you deal with it. On the other hand, once the original 
paper goes into an Out box, you may forget that you’re not finished 
working with it. It would be terrible to shred a bill you assumed 
you’d paid, but didn’t. 

• If you scan a document after dealing with it, you don’t have to 
worry about accidentally discarding it prematurely. On the other 
hand, dealing with a document might mean writing on it, tearing off 
a reply form, or altering it in other ways that shouldn’t happen until 
you’ve scanned the original. And, if papers accumulate in your In 
box for long periods of time, you could have exactly the same end 
result—an unpaid bill—as if you put it in an Out box and forget it. 

My own procedure is to scan first, then process by hand (tear off the 
form, sign the page, send the reply, etc.) immediately—before putting 
the scanned paper into the Out tray. You may or may not feel that’s the 
best procedure for you, but either way, be sure you think through the 
process you’ll follow, make a decision, and stick with it consistently. 
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Scan All Incoming Paper Immediately 
Once you have a physical paper path in place and have figured out 
what procedure you want to follow with incoming papers, just one 
thing remains: doing the actual scanning. Your software is already 
configured, so it should require no more than plopping the pages in 
the scanner’s sheet feeder and pressing a button. (For additional steps 
you might want to take after scanning documents, see the next topic.) 

However, I know from experience that as easy as that may seem, it’s 
easier still to let papers accumulate in an In box for a long period of 
time. And, the larger the stack of to-be-scanned papers becomes, the 
more daunting the task seems—meaning you’re that much more likely 
to keep putting it off. So, my advice is to make a new rule for yourself: 

Always process the contents of the In box before the end of the day. 

Obviously, I realize this isn’t always possible. As someone who works 
from home and has a young child in the house, I know all too well how 
easily distractions can arise. So interpret (or rework) this rule to suit 
your situation, but do remember that all things being equal, it’s easier 
to deal with this task immediately—or close to it—than later on. 
 

What If You Can’t Scan Something? 
Scanning is usually easy for letter- and legal-sized pages, as well 
as smaller items such as receipts and business cards. But what 
about things that won’t fit in your scanner? Some items are too 
large, too thick, too delicate, or for some other reason inappro-
priate for scanning. Here are two possibilities: 

• Use a carrier sheet. Some scanner manufacturers offer 
something called a carrier sheet, which is basically a pair of 
transparent plastic sheets joined at the top. You can put small 
or fragile documents in the carrier, or even a larger (folio-sized) 
sheet, folded in half—then scan the whole thing, and if neces-
sary, refold a larger sheet in the other direction and scan it 
again, combining the pages in software later. 

• Use a digital camera. Some OCR software works equally well 
on photographs as on scanned images, so if you can snap a 
picture with a digital camera, you’re all set. (See OCR on the 
Go for more information.) 
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Back Up Scanned Data 
If you’ll excuse me for preaching my usual sermon yet again, be sure to 
back up your data. Of course, backups are crucial for all your files, but 
if you’re scanning documents and getting rid of the originals (as will 
likely be the case more often than not), it’s all the more important. 

I said earlier, and want to repeat, that cloud storage is not the same 
thing as a backup—even if you also have a local copy of your files, 
and even if the cloud provider keeps multiple versions of your files 
(as, for example, Dropbox does). That’s all good and useful, but I still 
recommend having at least one separate, isolated backup from which 
there’s no possibility of accidentally deleting your files. 

To learn everything a Mac user needs to know about backups, read my 
book Take Control of Mac OS X Backups; or, for a quicker and simpler 
approach that covers only the basics, see Take Control of Easy Mac 
Backups. 

Keep Legally Important Documents 
Your utopian vision of a paperless office may include the idea of 
putting all scanned documents straight into the shredder or recycling 
bin, so that you truly have no paper in your office, except during the 
brief moments when it’s passing through your scanner. Or, at the very 
worst, you may picture yourself printing a scanned copy of any docu-
ment that someone urgently needs to see on paper. 

But not so fast! Until the rest of the world catches up with this hopeful 
notion, it’s still going to be mandatory to preserve—and be prepared 
to produce—the originals of certain kinds of documents. I’m thinking 
especially of government documents and anything that might have to 
stand up in a courtroom some day. Because digitized files are merely 
pictures, they can be forged or altered, and for that reason they can’t be 
accepted as legally valid in certain situations. 

To give you some examples—not by any means a comprehensive list—
consider the following types of documents for which you should always 
keep the originals, even though you’ve scanned them: 

• Birth, death, and marriage certificates 

http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/backup-easy-mac?pt=INTERNAL
http://www.takecontrolbooks.com/backup-easy-mac?pt=INTERNAL
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• Deeds 

• Diplomas 

• Licenses 

• Notarized contracts 

• Passports, visas, and related documents 

• Stock certificates 

• Titles 

• Wills 

• Anything with an embossed seal 

• Anything printed on security paper 

In all such cases, it can be useful to have scanned copies (for reference, 
and as a backup in case of loss or theft), but because it’s likely that the 
originals will carry much more weight than digital facsimiles, it’s best 
to preserve those originals in a secure place. 

Recycle or Shred Leftovers 
At this point, the disposition of any originals left in an Out box may be 
a trivial concern, but I’ll mention it anyway. After you’ve scanned your 
papers and filed those you need to keep (as in the previous section), all 
that’s left is to direct the rest into a shredder or a recycling bin. 

To preserve your privacy and reduce the risk of identity theft, I suggest 
shredding anything with personally identifying information (such as 
address, telephone number, or social security number) on it, as well as 
any financial records. 

Apart from that, recycle if at all possible and save a tree or two.  
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Work Through a Backlog 
 
Your scanner, OCR software, and paperless workflow may do a 
marvelous job of helping you deal with new paper as it comes in. 
But if you already have tens of thousands of pages in filing cabinets, 
you need to deal with all those existing documents too. It can feel 
overwhelming, but with the right approach you can work your way 
through even a substantial backlog in a reasonable period of time. 

Prune Unnecessary Documents 
I grew up in a family of packrats, so to some extent I always feel a 
compulsion to save everything—not for any specific reason, but just 
in case it might turn out to be useful some day in the distant future. 
I try valiantly to fight it, but it always feels a bit painful to get rid of 
anything. That includes papers, of course, so for many years I accum-
ulated box after box and drawer after drawer of papers, most of which 
I’ll clearly never need to see again. 

When I began contemplating my paperless office project, it was 
obvious that many of those papers could and would disappear, but 
the significant question was whether they should be scanned first. 
If I scanned everything, it could take months, and much of that time 
would be wasted, because the digital copies would do me as little good 
as the paper copies. 

So I readied a recycling bin, steeled myself, and adopted the most 
ruthless attitude I could muster—and then went through all my paper 
files, tossing as many as possible. Quite a few struck me as borderline, 
so I left them, but then repeated the process every six months or so, 
and each time found more papers I felt I could live without having in 
either physical or digital form. 

If you’ve got such a huge collection of papers that scanning them all 
would be inconceivable, consider doing the same thing. Everyone’s 
different, but I can offer some general words of advice about pruning: 

• Start with the low-hanging fruit. You know you can get rid of 
old junk mail, printouts of documents you already have in digital 
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form, duplicate copies, unused reply envelopes, and numerous 
other items, so take an initial pass through your documents and toss 
the easy stuff first. 

• Take your time. You don’t have to prune all the unnecessary stuff 
in one session. Do a quick pass now, then another one in a few 
weeks or months. Over time it gets easier! 

• Use logic. For those of you who pay taxes in the United States, the 
IRS strongly recommends that you keep tax-related records for the 
last 3–7 years, depending on the type of document. Fine, but if (like 
me) you’ve saved every receipt and cancelled check back to the mid-
1980s, your actions defy logic and serve no useful purpose. If you 
can’t come up with a plausible scenario in which a document might 
someday be needed, out it goes. 

Tax tip: To learn exactly what the IRS suggests in terms of 
preserving documentation, read the informative PDF document 
“Recordkeeping for Individuals” (http://www.irs.gov/pub/irs-
pdf/p552.pdf). Of special note: the IRS accepts electronic copies 
of documents and even permits you to destroy paper originals, 
as long as certain criteria are met. Obviously, this applies only 
to U.S. taxes—for other countries, check with your tax authorities. 

• Respect history and emotion. In the interest of balance, I must 
admit that some papers have sentimental or historical value, even 
if they have no practical value. If those old love letters, high school 
papers, or other artifacts produce tears of nostalgia; if they might 
come in handy when writing your memoirs; or if you want to be able 
to show them to your grandchildren in physical form, then by all 
means keep them! 

Prioritize What’s Left 
If you’re left with more papers than you can comfortably scan in a 
week or so, it’s crucial to prioritize them. You could get interrupted, 
distracted, or delayed, and the project of scanning everything might 
drag on for longer than you imagined. So scan things in order of 
importance. 

http://www.irs.gov/pub/irs-pdf/p552.pdf
http://www.irs.gov/pub/irs-pdf/p552.pdf
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I suggest, at minimum, having three categories—urgent, normal, 
and low priority. (This might translate into three physical piles, or it 
might simply be the way you think about documents as you go through 
them.) Scan all the urgent documents first; then all the normal docu-
ments; then the low-priority ones. 

If some category contains vast numbers of papers, I suggest scanning 
them in roughly reverse chronological order. In my experience, I’m 
much more likely to need the text of recent documents than older ones. 

Try Scanning 50 Sheets Per Day 
Still overwhelmed by all the pages to be scanned? Break it down into 
manageable chunks. For example, commit yourself to scanning just 
50 sheets of paper per day (while, of course, also keeping up with new, 
incoming paper). Even the slowest scanner I mention in this ebook can 
churn through that many pages in less than 15 minutes, and the fastest 
can do it in under 2 minutes. That shouldn’t be a burden on anyone’s 
schedule. 

But look at the results: In two work weeks, you’ll have polished off 
an entire ream of paper. And in a year, you’ll have gone through up to 
13,000 pieces of paper—not too shabby! 

Hire a Minion 
If you simply can’t devote the necessary time to scanning everything, 
why not hire someone to do it for you? It’s easy work, and it could 
be a nice gig for a student wanting part-time work. Or contact a local 
temp agency—they can undoubtedly hook you up with someone who’s 
qualified, inexpensive, and grateful for a few extra bucks. 

Outsource Scanning 
For truly gargantuan backlogs, you can call in the pros. There are com-
panies that will pick up (or let you ship them) boxes of papers, have 
trained professionals scan and digitize them, and then hand you back 
your originals and the digital copies. Some services even offer on-site 
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scanning. Examples of document scanning companies that I found in a 
quick Google search: 

• Innodata Isogen: http://www.innodata-isogen.com/services/ 
digitization_and_imaging 

• P2E: http://www.p2escan.com/ 

• Scan 2 Disc: http://www.scan2disc.com/scanning.htm 

• Scantronix: http://www.scantronix.net/ 

 

http://www.innodata-isogen.com/services/digitization_and_imaging
http://www.innodata-isogen.com/services/digitization_and_imaging
http://www.p2escan.com/
http://www.scan2disc.com/scanning.htm
http://www.scantronix.net/
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OCR on the Go 
 
Perhaps you bought a portable scanner (see Portable Scanners) to 
take with you on business trips. That’s great—but you can’t always 
have your scanner with you. And even if you did, it wouldn’t help 
with documents that won’t fit in it—menus, posters, billboards, 
street signs, and so on. But all these and more are still fair game for 
capture and OCR. You just need a digital camera (which could be 
the one built into your iPhone or other smartphone) and an app to 
do the necessary processing. With the right mobile tools, you may 
find yourself scanning receipts and business cards on the spot. 

Learn about Pocket-sized OCR Tools 
Very likely you have a device in your pocket that includes a camera, a 
wireless network connection, and the capability of running third-party 
software. If so, you can do many of the same things you can do with a 
desktop or portable scanner and OCR software, and in fact you can do 
a few cool things more easily. For example: 

• You can store photos of business cards, receipts, signs, posters, 
billboards, and the like in the cloud, and be able to search their text 
along with all your other notes and documents. 

• You can photograph large or awkwardly shaped documents and 
perform OCR on them almost instantly. 

• You can snap a picture of a menu at a French restaurant and, a few 
seconds later, get an English translation. 

• You can capture an image of something containing text and have 
that text read to you by a synthesized voice. (Sometimes, you can 
even combine this with translation!) 

These sorts of tools are great for travelers, especially those who spend 
time in places where they don’t read the local language well. But 
they’re also useful for anyone who, from time to time, wants to create 
a searchable record of something they can’t physically put through a 
scanner for one reason or another. 
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I should mention that in many cases, apps that run on mobile devices 
don’t produce searchable PDFs as such. The data may be stored in 
some other format, or you may need to use a proprietary system for 
searching it. Even so, the advantages to such apps are enormous. 

Pick an iOS OCR App 
In my household, all the mobile data gadgets are made by Apple, so 
I’m most familiar with apps that run under iOS. When I first looked 
into mobile OCR apps, I was astonished to find more than 100 apps 
in the iTunes Store that have OCR capabilities of one sort or another 
(search for “OCR” and you’ll see what I mean). So you have no short-
age of choices. 

Most of these apps focus on capturing business cards, receipts, or 
both—a nice way for business users to avoid accumulating papers. 
However, some have features optimized for travelers, while others are 
general-purpose data collection tools. Some OCR apps for iOS upload 
images to a server, which performs OCR in the cloud and then returns 
the resulting text, but others can perform OCR on the device itself. 

I should point out, however, that for capturing documents, especially 
at close range, you’ll get the best results with an iPhone 3GS or 
iPhone 4 (both of which have cameras that can focus), and of the two, 
an iPhone 4 will produce better results because its sensor has a higher 
resolution and better low-light performance (not to mention the fact 
that it has an LED “flash”). In fact, some of these apps don’t work at all 
on first-generation iPhones, the iPhone 3G, or fourth-generation iPod 
touch models (even though they have cameras). 

Clarified: If you have an iPhone 3G, you may be able to use Griffin’s 
Clarifi case, which includes a built-in close-up lens, to get photos 
sharp enough to work with OCR apps. 
(http://www.griffintechnology.com/products/clarifi, $34.99) 

Although I can’t begin to do justice to the huge range of iOS apps in 
this category, here are a few representative examples: 

• Babelshot: Take a picture of text in any of 32 different languages, 
and Babelshot not only performs OCR but also translates that text 
into English. ($4.99) 

http://www.griffintechnology.com/products/clarifi
http://itunes.apple.com/us/app/babelshot-photo-translator/id334194705?mt=8
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• Business Card Reader: Recognizes business cards in seven 
languages, and connects to LinkedIn. ($5.99) 

• CamCard: Supports OCR of business cards in 12 languages, and has 
a very high customer rating. ($6.99) 

• CardMunch: This software offers “100% guaranteed accuracy” when 
scanning business cards because each scan is verified by a human 
being. But you pay an extra per-scan fee (cost varies based on 
volume) for that accuracy. ($2.99) 

• DEVONthink To Go: This app lets you sync the contents of your 
DEVONthink (Personal, Professional, or Pro Office) or DEVONnote 
database with your iOS device. If you take a picture and then sync it 
with your Mac, the desktop application can automatically perform 
OCR—although the recognized text is stored as a comment within a 
JPEG file. ($14.99) 

• DocScanner: A general-purpose OCR tool for creating searchable 
PDFs, DocScanner performs the OCR on your iOS device itself—no 
network connection required. ($5.99) 

• Page Scanner: Another general-purpose OCR app; can create either 
searchable PDFs or plain text files. ($5.99) 

• Prizmo: Prizmo offers OCR for all types of documents and performs 
the OCR directly on your iOS device; it also lets you do many of the 
same image-enhancement tasks (such as fixing skewed perspective) 
that the desktop version can do. ($9.99) 

• WorldCard Mobile: This highly rated business card scanner 
recognizes text in seven languages. ($5.99) 

• XpenseTracker: This full-featured business expense tracking app 
also offers OCR for receipts. ($2.99) 

Use Other Smartphones 
If you have a smartphone that runs another OS, you still have 
numerous options. I was able to find quite a few OCR apps for the 
other two leading smartphone platforms, Android and Blackberry.  
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http://itunes.apple.com/us/app/business-card-reader/id328175747?mt=8
http://itunes.apple.com/us/app/camcard-business-card-reader/id347803339?mt=8
http://itunes.apple.com/us/app/cardmunch-100-accurate-business/id367471769?mt=8
http://itunes.apple.com/us/app/devonthink-to-go/id395722470
http://itunes.apple.com/us/app/docscanner/id312391317?mt=8
http://itunes.apple.com/us/app/page-scanner/id368331275?mt=8
http://itunes.apple.com/us/app/prizmo/id366791896?mt=8
http://itunes.apple.com/us/app/worldcard-mobile-business/id333211045?mt=8
http://itunes.apple.com/us/app/xpensetracker/id290874373?mt=8


94 

Android 
Next to iOS, the greatest range of choices for mobile OCR exists on the 
Android platform. Just a smattering of the many options: 

• BabelSnap (http://www.babelsnap.com/, $2.99) 

• CamCard (http://www.intsig.com/home/us/2010-09-15-02-46-24, 
$14.99) 

• DocScanner (http://www.docscannerapp.com/, $4.99) 

• Document Scanner 
(http://www.pwnwithyourphone.com/document-scanner, $3.98) 

• Droid Scan 2 (http://droidscan.com/, $4.98) 

• Evernote for Android 
(http://www.evernote.com/about/download/android.php, free) 

• Portable Scanner (http://www.silkenmermaid.com/, $1.99) 

• Scan2PDF Mobile (http://www.burrotech.com/, £9.99) 

BlackBerry 
The BlackBerry OCR apps I was able to find focus almost entirely on 
business cards and receipts: 

• Abukai Expenses 
(http://appworld.blackberry.com/webstore/content/14590, free) 

• Business Card Reader 
(http://appworld.blackberry.com/webstore/content/5987, $9.99) 

• CamCard 
(http://appworld.blackberry.com/webstore/content/13707, $11.99) 

• CardSnap 
(http://appworld.blackberry.com/webstore/content/2089, $4.99) 

• Cognicard 
(http://appworld.blackberry.com/webstore/content/10660, free) 

http://www.babelsnap.com/
http://www.intsig.com/home/us/2010-09-15-02-46-24
http://www.docscannerapp.com/
http://www.pwnwithyourphone.com/document-scanner
http://droidscan.com/
http://www.evernote.com/about/download/android.php
http://www.silkenmermaid.com/
http://www.burrotech.com/
http://appworld.blackberry.com/webstore/content/14590
http://appworld.blackberry.com/webstore/content/5987
http://appworld.blackberry.com/webstore/content/13707
http://appworld.blackberry.com/webstore/content/2089
http://appworld.blackberry.com/webstore/content/10660
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Use Your Digital Camera 
If you don’t have a smartphone, or if its camera isn’t of sufficient 
quality for the results you want, you can snap a picture with any digital 
camera, upload it to your Mac, and run it through your favorite OCR 
software to produce a searchable PDF. 

However, let me offer a few tips: 

• Make sure you have stand-alone OCR software. When 
scanner manufacturers bundle third-party OCR software, often it’s 
intentionally crippled in such a way that it works only with scans 
made by that scanner, and won’t process other files you throw at it. 
If you buy OCR software on its own, it won’t have this limitation. 

• Watch image quality. Make sure your subject is well-lit, in focus, 
and photographed from as straight an angle as you can manage. 

• Zoom. Compose your image so that the text you want to recognize 
fills as much of the frame as possible; this provides more pixels for 
your OCR software to work with. 

 

OCR for Students and Researchers 
In college and graduate school I spent countless hours in libraries 
collecting books and journals, and then photocopying just the 
pages I needed and taking those with me for further study. 
Nowadays, I might snap a digital photo of the relevant pages 
instead, but there’s yet another option: the handheld scanner. 

Several companies make wand- or pen-shaped scanners that you 
can connect to your Mac laptop and swipe over the portion of a 
page you want to capture. They’re much more compact than even 
the smallest portable document scanner, and you can use them 
with books and other bound items. For example: 

• DocuPen X Series 
(http://www.planon.com/products/docupen/xseries, prices 
range from $299.99 to $399.99) 

• IRISPen 6 (http://www.irislink.com/c2-1692-225/IRISPen-
6.aspx, prices range from $129 to $299) 

• VuPoint Magic Wand (http://www.vupointsolutions.com/PDS-
ST410-VP.asp, $99.99) 

http://www.planon.com/products/docupen/xseries
http://www.irislink.com/c2-1692-225/IRISPen-6.aspx
http://www.irislink.com/c2-1692-225/IRISPen-6.aspx
http://www.vupointsolutions.com/PDS-ST410-VP.asp
http://www.vupointsolutions.com/PDS-ST410-VP.asp
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Avoid Common 
Printing Needs 
 
Now that you’ve taken numerous steps to avoid receiving paper 
from others, and to get rid of the paper you still do receive, there 
remains another piece of the puzzle: how to stop generating more 
paper of your own. Kicking the printing habit can be hard, but in 
this chapter I help you to identify alternative ways in which you can 
achieve roughly the same end result. 

Think (and Track) When You Print 
You may hit Command-P dozens of times each day, out of habit 
or necessity. Sometimes printing truly is necessary—until all your 
business associates and family members join the paperless revolution, 
you’ll be obligated to print certain things for their consumption. But 
countless pages are printed every day just because the documents’ 
creators wanted to have copies “for their records” or “just in case.” 
Those printed pages are the ones you can most easily eliminate. 

So, as an exercise, try this for a week. Put a piece of paper—yes, 
paper!—next to your printer, with three columns: Document, Pages, 
and Purpose. Every single time you pick up something from the 
printer, jot down the following information: 

• Document: Could be the document’s name, or just a word or two 
that reminds you what it was. 

• Pages: The number of pages in that document. 

• Purpose: Let’s keep it simple, and make it one of F (for file), R 
(for review), or O (for other people). Things you print out simply 
to put in a folder or filing cabinet get an F; things you print out 
because you need to read them on the plane, or mark them up with 
comments, or otherwise review them, get an R; and things you print 
because you have to give or send them to someone else get an O. 
(Feel free to expand or customize this list according to your needs.) 



97 

At the end of the week, review your list. You may be surprised at 
how many pages you’ve printed, and of those, how many are less 
than essential. Merely paying attention to what you print may help 
you to be more conscious of how (un)necessary certain printouts are, 
and to cut back accordingly. But you may be able to go further still.  

You’re looking to eliminate as many of the “F” and “R” items as you 
can. I hope I’ve persuaded you in the course of this book that digital 
copies of files (which you already have, since you printed them) are 
just as useful as printed copies, and often more so—as long as they’re 
diligently preserved and backed up. So unless you’re complying with 
rules set down by your employer, the government, or some other 
entity, the only thing forcing you to keep printing “F” items is habit. 
Try going without printing those items for a week or two (keeping in 
mind the other suggestions later in this chapter) and see how you feel. 

And as for the “R” items… 

Review and Annotate Documents 
If you’ve spent years editing documents by hand, on paper, in red ink, 
it can feel unsettling to think about switching to a paperless method. 
I can’t change how you feel, but I can tell you that paperless reviewing 
and annotation tools exist, are both powerful and easy to use, and offer 
numerous advantages over paper. I think they’re well worth a try. 

Many Mac applications that can open PDFs—including Preview 
(included with Mac OS X), DEVONthink, and Acrobat Pro, among 
others—can also annotate them. Annotations are markings and notes 
that appear on a transparent “layer” above the document itself. Anno-
tations don’t alter the contents of the document, but they do add lines, 
shapes, sticky notes, comments, and in some cases traditional copy-
editing marks. You can even use annotations to highlight text, in much 
the same way you could with a pen and highlighter. But, on a PDF, 
you’re not limited in the length or number of comments (you’ll never 
run out of virtual space); you can use multiple colors; and many people 
can annotate a document without making it unusable. 

Yes, but how? Consult the Help menu in Preview or your favorite 
PDF application for instructions on using its annotation features. 
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An increasing number of iOS apps can do the same thing. I find the 
iPad, especially, to be an excellent substitute for paper when annotat-
ing PDFs, because the screen is so large and the virtual keyboard more 
comfortable to type notes with. (To learn more about iPad apps for 
annotating PDFs, see Take Control of Working with Your iPad.) 

Take Notes without Paper 
For those of us who spend hours every day sitting in meetings or 
making phone calls, note-taking is one of the most common reasons 
to generate lots of paper. You already know you can take notes on a 
computer, but that’s not always practical—especially if you’re not a 
touch typist or if the use of a laptop in a meeting would be distracting. 
And although it’s possible to type notes on an iPhone or iPod touch, 
it’s tedious to do so except when the notes are quite short. 

However, once again, the iPad makes a fantastic tool for taking notes. 
You can either type on its almost-full-size virtual keyboard or write 
on the screen with a fingertip or a stylus (available from several third 
parties) using a suitable note-taking app. And I know of at least one 
(WritePad for iPad, $9.99) that offers handwriting recognition, rather 
than simply saving your scrawled notes as a graphic. I include an entire 
chapter on note-taking in Take Control of Working with Your iPad. 

Send Invoices Electronically 
Earlier in this book I suggested that you Receive Invoices Electroni-
cally, if your work requires processing invoices from others. If, on the 
other hand, you bill someone else for your products or services, you 
can return the favor by sending your invoices electronically. Besides 
saving paper, envelopes, and stamps, electronic invoicing is faster and 
more efficient. 

Before you switch to electronic invoicing with any of your clients, check 
with them to make sure they agree, and ask where invoices should be 
sent. (They may, for example, ask that you email them to a particular 
address in the billing department.) If a client can’t accept emailed 
invoices, see if fax is acceptable—and then read Fax without Paper to 
find out how to send your faxes by email. 

http://www.takecontrolbooks.com/ipad-working?pt=INTERNAL
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fwritepad%2Dfor%2Dipad%2Fid363618389&ul=tc
http://www.takecontrolbooks.com/ipad-working?pt=INTERNAL
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Although most businesses can read email attachments in common 
formats like .doc, I recommend always sending invoices as PDF files. 
Not only is PDF the most universal format, but a PDF is much less 
likely to be accidentally altered by the recipient. 

To email an invoice from whatever application you normally use to 
create invoices, do this: 

1. Choose File > Print. 

2. From the PDF pop-up menu in the bottom-left corner of the Print 
dialog, choose Mail PDF. 

Or add a step: This creates a PDF and attaches it to an outgoing 
email message automatically, but doesn’t give you the opportunity 
to rename the attachment (see Choose a Naming Convention) or 
save a copy for your records. If you want to do either of these 
things, instead choose Save as PDF, name and save the file, and 
manually attach it to a new email message. 

3. In a few moments, your email client should display a new message 
window, with the PDF already attached. Fill in the recipient, sub-
ject, and body of the message, and click Send. 

Fax (Paperlessly) When Email 
Isn’t an Option 
There’s an entire chapter on this topic (Fax without Paper) later in 
the book, but I wanted to bring it up here because a common reason to 
print something is so you can fax it using a conventional fax machine. 
Although some documents can be sent only by fax and not, say, as 
email attachments, that doesn’t mean you have to print anything. So 
if you’re still using a stand-alone fax machine, take this opportunity to 
read up on other approaches, and then free up even more desk space! 

Always Print to PDF When Possible 
If you pay bills, make purchases, or plan travel online, you’re bound 
to see quite a few Web pages that summarize your transaction and 
urge you to print the receipt for your records—maybe even with an 
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ostensibly helpful “printer-friendly format” button. Yes, you should 
keep records of your purchases and payments. But no, you don’t have 
to print these pages to do so—at least not on paper. 

Instead, when you see one of these pages, do one of the following: 

• See if an email receipt arrives too. More often than not, when 
I make purchases online I get a receipt by email within minutes, 
and that receipt contains exactly the same information that’s on the 
“print me” page. Since I save my incoming email, I already have a 
record of the transaction and don’t need another one. 

• Print to PDF. While viewing a Web page (or a document in almost 
any Mac OS X application), you can save it as a PDF in a special 
folder—~/Documents/Web Receipts—with just two clicks: 

1. Choose File > Print. 

2. From the PDF pop-up menu in the bottom-left corner of the 
Print dialog, choose Save PDF to Web Receipts Folder. 

I do suggest visiting the ~/Documents/Web Receipts folder from 
time to time and moving the files to more specific locations (as well 
as, if necessary, renaming them) so that you can find them easily. 

• Print a PDF to a document manager. Some document 
managers, including DEVONthink, add their own commands to 
the PDF pop-up menu described in the previous item. So instead 
of choosing Save PDF to Web Receipts Folder, you could instead 
choose (for example) Save PDF to DEVONthink Professional, 
which can then categorize it manually or automatically. 

Never Print “Just in case” 
I have to admit I do this myself on occasion, even today. There are 
certain kinds of documents that I’m so accustomed to printing, or 
so paranoid about having when I need them, that I instinctively hit 
Command-P when they appear on my screen. 

I’m thinking of things like travel itineraries, for example—since I have 
an e-ticket, won’t I need to show something to the agent at the check-
in desk? (In fact, I know I don’t; I just need to show them ID, and they 
can look up my reservation in their computer.) The same goes for 



101 

certain receipts, such as when I pay my taxes online, and other 
documents for which the stakes are fairly high—I absolutely must be 
able to prove that I made that reservation, paid that fee, or whatever. 

But what I know deep down inside is that nearly always, I’m no better 
off having a piece of paper than having a digital copy of the same 
document on my iPhone or iPad. Sure, I may need a confirmation 
number or evidence that I bought something, but almost without 
exception, the information itself—not the physical copy of it—suffices. 

In other words: print only when you know you’ll need a document on 
paper, not out of habit or when you only worry that you might need it! 

Carry a Mobile Device Instead of Paper 
I always carry an iPhone with me, and when that’s not adequate for 
my needs, I take my iPad too. These devices, along with the iPod touch, 
let you store and display PDF files (including ones you’ve scanned)—
not to mention books, newspapers, and other documents that would 
otherwise require a lot of paper. Android devices can also display 
PDFs using, for example, Adobe Reader (http://blogs.adobe.com/ 
adobereader/2010/05/introducing_adobe_reader_for_a.html, free); 
BlackBerry users can install an app such as BeamReader 
(https://appworld.blackberry.com/webstore/content/1306, $9.99). 

So instead of printing out a receipt, travel itinerary, or other document 
you received online, copy it to your mobile device. It’s almost always a 
suitable substitute for paper, and in some cases (I hasten to point out 
that it’s not universal), electronic tickets for things like movies and 
concerts, which feature a barcode, can be scanned directly from your 
mobile device at the door rather than from a piece of paper. And, of 
course, you can use your mobile device for taking notes, managing 
shopping lists, and other tasks that would ordinarily require paper. 

The options for transferring PDFs to a mobile device vary by platform. 
On an iOS device, for example, you could copy them to your Dropbox 
or iDisk, and then use the free Dropbox or MobileMe iDisk app to 
view them on the go. Another favorite of many Take Control folks 
is GoodReader for iPhone, which also works on the iPod touch, and 
GoodReader for iPad ($1.99 each). I explore many other such apps in 
Take Control of Working with Your iPad. 

http://blogs.adobe.com/adobereader/2010/05/introducing_adobe_reader_for_a.html
http://blogs.adobe.com/adobereader/2010/05/introducing_adobe_reader_for_a.html
https://appworld.blackberry.com/webstore/content/1306
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fgoodreader%2Dfor%2Diphone%2Fid306277111&ul=tc
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fgoodreader%2Dfor%2Dipad%2Fid363448914&ul=tc
http://www.takecontrolbooks.com/ipad-working?pt=INTERNAL
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Read Paperlessly 
Business documents aren’t the only form of paper clutter. If 
you really want to go paperless, you can also find digital versions 
of many newspapers, magazines, and books—which can be con-
sumed on your computer, an iOS device, or an ebook reader such 
as the Kindle or Nook. 

I’d be the first to admit that the experience of reading books 
and periodicals on a screen rather than on paper is not uniformly 
great. I’ve read a few full-length books on my iPhone 4, and 
some magazines and newspapers on my iPad, that I’ve enjoyed 
thoroughly. But I’ve also seen many electronic publications whose 
style and usability were distinctly inferior to their paper versions. 

Although the world of e-publications is rapidly evolving, I can offer 
at least a few words of advice for those considering moving from 
paper to silicon for most of their reading: 

• Handheld devices are better. There are ways to read many 
books and periodicals on computer screens, but the size, shape, 
and weight of handheld devices makes the overall experience of 
reading books on them way better in most cases. 

• Resolution matters. Although my iPad’s display is physically 
larger than that of the iPhone, I prefer reading books on my 
iPhone 4—even with all the extra page-turns. For me, the 
added crispness of the iPhone 4’s Retina display makes a world 
of difference. (Someday, no doubt, the iPad will get a Retina 
display too, and then I’ll happily switch.) E-readers such as the 
Kindle and Nook also have higher-resolution displays than the 
(first-generation) iPad, though not as high as the iPhone 4. 

• Think about lighting. Proponents of E Ink displays like the 
one on the Kindle boast that you can read them in bright sun-
light at the beach. That’s great, but 99.999 percent of the time, 
I read books indoors—or at least in the shade—anyway. Think 
about where you do your reading when choosing a display type. 

• Think about multimedia. Even though I like my iPhone’s 
display for text, I prefer the iPad when it comes to publications 
with lots of graphics or video. If you expect to read periodicals 
with more than just text, look for a large, color display. 
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Sign Documents 
without Paper 
 
When a document requires a signature, it’s natural to assume that 
requires ink on paper. And sometimes it does, but in a great many 
situations, you can “sign” and electronically deliver a document, 
whether you originally received it in digital or physical form. 

In this chapter I begin by talking about situations in which the 
recipient needs to see your handwritten signature. For many con-
tracts, legal agreements, and other day-to-day business documents, 
you can substitute a scanned copy of your signature. 

There’s also another concept you should be aware of—a digital 
signature, which is a way of certifying that you, and you alone, are 
the sender of a message or the signatory of a document. I cover this 
sort of signature briefly toward the end of the chapter. 

Determine When a Pseudo-Signature 
Is Acceptable 
When someone asks you to sign a document, simply ask this question: 

Can I return this by fax or email, or is an original signature required? 

You’d be surprised how often electronic transmission of a signature 
is considered perfectly valid. I’ve done this dozens of times myself—for 
example, when returning contracts for writing magazine articles and 
doing technical reviews for new books. If the other party is content 
with fax or email, I’m only happy to oblige. (And, as I explain shortly, 
you can send a fax by email, so it amounts to the same thing.) In cases 
where only an original signature is accepted, I send a piece of paper, 
but in my recent experience that happens mainly in cases where the 
thing to be signed is of tremendous gravity (or a lot of money is 
involved). You’ll probably need ink on paper for a lease, bank loan, 
or affidavit, but for run-of-the-mill contracts and agreements, an 
electronic signature should suffice. 
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Scan Your Signature 
To be able to fax or email signed documents without generating more 
paper, the first thing you need is a good digital copy of your signature. 
To make one, follow these steps: 

1. On a clean, white, unlined sheet of paper, sign your name in dark 
ink at a normal size. 

The one or the many: If your signature takes on multiple forms, 
put them all on the paper. For example, sometimes I sign my name 
“Joe Kissell,” sometimes “Joseph Kissell,” and sometimes “Joseph 
W. Kissell,” depending on the context. 

2. Scan the page with your signature. If your scanner is normally set 
to reduce the resolutions of scans, bump it back up for this one—
600 dpi is a good choice. And, even if you sign your name in black 
ink, do the scan in color. These extra tweaks will improve the 
quality of your scanned signature, which will in turn increase its 
perceived authenticity and the flexibility you have in using it later. 

3. In your favorite image editing program (such as Preview, Photoshop 
Elements, or GraphicConverter), open the scanned image, crop it 
so that only a few pixels of white appear around the outside, and 
confirm that the white truly is white. (If it’s gray, or speckled, or 
otherwise “noisy,” adjust the contrast or brightness, or use whatever 
other tools your image editor provides to eliminate the noise.) 

4. Optional: If you have the image editing kung fu to make the back-
ground of your signature transparent, do so (sorry, it’s too involved 
to explain here); this lets elements of the original PDF, such as a 
signature line, show through the background. 

The PDFpen is mightier: If you have PDFpen (or PDFpenPro), 
you need not bother with creating a transparent background, 
because PDFpen has a built-in command to make your signature’s 
background transparent when you add it to a PDF. Competing 
tools don’t have this capability, so transparency comes in handy 
in those tools. 
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5. Save the file in either TIFF or PNG format (your choice, but PNG 
files tend to be smaller). 

You now have a graphic file (or perhaps more than one) consisting only 
of your signature, with either a white or transparent background. Make 
sure you keep this in a convenient location. 

Superimpose Your Signature on a PDF 
Now comes the fun part: you open the PDF of the document to be 
signed, overlay the image of your signature, and save the composite 
image as a new file, which looks like you physically signed it. 

I know of at least four tools offhand that can pull off this trick on a 
Mac, and one of them is even free. But let me be candid here: one of 
them—PDFpen—does a much better job than the rest, and that’s the 
one I recommend. (PDFpenPro has the same capability.) So, I’m going 
to provide complete directions for doing this with PDFpen, but only 
cursory instructions for doing it with a few other tools. 

Add a Signature with PDFpen 
To add your scanned signature to a document using PDFpen, follow 
these steps: 

1. Open the PDF needing a signature in PDFpen. 

2. Choose File > Insert (or click the Insert button on toolbar), navigate 
to the scanned image of your signature you created earlier, and click 
Open. PDFpen places your signature on the page. 

3. Drag your signature to the desired location on the page and, if 
necessary, resize it by dragging one of its corners. 

4. If your signature doesn’t already have a transparent background, 
select it and choose Edit > Make Transparent Image. In the dialog 
that appears, click once in the white space surrounding your sig-
nature, and then click Make Transparent. 

5. Save and close the document (or, if you prefer, use File > Save As to 
save a copy with your signature, keeping the original intact). 

You can now attach the signed PDF document to an email message. If 
only fax is acceptable, no problem—you can use any of the email-to-fax 
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gateways described in the next chapter (Fax without Paper) to send a 
fax without a fax machine. 

Store Your Signature in PDFpen for Easy Access 
If you’ll be adding your signature to PDFs frequently in PDFpen, 
you may wish to add your signature to the PDFpen library. To do 
so, place your signature in a PDF as in Steps 1–4 just previously, 
and make sure the signature image is selected. Then, click the 
Library button on the toolbar. In the Library window, from the Add 

 pop-up menu at the lower left, choose Add Selected Imprint. 
PDFpen adds your graphic, including transparency, to the Graphics 

 portion of the library. Next time you want to insert your signa-
ture in a PDF, simply click the Library button on the PDFpen tool-
bar, click the Graphics  button, and then click your signature. 
 

Add a Signature with Acrobat Pro 
Acrobat Pro has two different methods of affixing the image of a sig-
nature to a PDF. One of them is as part of a digital signature, which I 
describe in a moment (see Learn About Digital Signatures, later in this 
chapter). The other, simpler method uses something Acrobat calls a 
stamp, which can be any graphic that’s overlaid on a PDF. 

The basic method is to create one or more signature stamps by 
choosing Tools > Comment & Markup > Stamps > Create Custom 
Stamp and adding an image of your signatures. These stamps can 
then be reused whenever you need them. Having configured a stamp, 
choose Tools > Comment & Markup > Stamps > Category Name > 
Stamp Name, and click to place the image at the desired spot. 

Add a Signature with PDF Studio 
PDF Studio, like Acrobat Pro, uses stamps to superimpose images 
on a PDF. Set up a stamp by choosing Comments > Add Stamp > 
Create Custom Image Stamp and directing it to the scan of your sig-
nature. Once you’ve done that, you can sign a document by choosing 
Comments > Add Stamp > Category Name > Stamp Name and 
clicking to place the image at the right location. 
(http://www.qoppa.com/pdfstudio/, Standard version, $60; Pro 
version, $95) 

http://www.qoppa.com/pdfstudio/
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Add a Signature with FormulatePro 
FormulatePro, unlike the other tools mentioned in this section, is 
completely free. It also offers the easiest way to add an image of your 
signature to a PDF. Just choose File > Place Image, navigate to your 
image, click Open, and then move the graphic to the desired location. 
(http://code.google.com/p/formulatepro/, free) 

Digital Forgeries 
When you superimpose an image of your signature on a PDF, this 
only gives the appearance of a genuine signature. It wouldn’t be 
accepted for documents of great importance because it’s easy to 
fake. All anyone has to do is scan your signature (from, say, a 
credit card receipt or a hotel register) and they could “sign” some-
thing as you. So, let’s be clear: this is not a high-security option. 

But there’s another way of signing electronic documents that is 
quite secure—that’s a digital signature, which I discuss next. 

Learn about Digital Signatures 
If your work requires you to send or receive signed legal documents 
of significant gravity, the sort of pseudo-signatures I’ve talked about 
so far in this chapter won’t cut it, because they’re too easy to fake. 
However, it is possible to prevent forgeries and “sign” digital docu-
ments in a way that is, in fact, much more secure even than using a 
pen. A digital signature does just that. 

When you digitally sign a document, you embed in it information 
about yourself (such as your name and email address)—and possibly 
a graphic representing your handwritten signature. But this isn’t mere 
ornamentation; you’re adding a specially encrypted certificate (some-
times called a digital ID) that the recipient can validate to confirm that 
the signature truly is yours. The software you use to sign a document 
does something else, too: it calculates a unique value based on the con-
tents of the document and includes an encrypted copy of that value in 
the signature. The result is that if the document were altered in even 
the tiniest way, this value would no longer be accurate, and the recipi-
ent would know that the document had been tampered with. 

http://code.google.com/p/formulatepro/
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So, tamper-proof digital documents that can be reliably connected with 
a signatory sound great—there’s got to be a catch, right? Yep. In fact, 
there are several: 

• Multiple mutually incompatible standards exist for digitally signing 
documents. Unless all parties involved use the same system, the 
process won’t work. 

• Very few Mac OS X applications can digitally sign PDF documents, 
which are of primary concern in this ebook. Acrobat Pro can, and so 
can PDF Studio Pro, but if you open a signed PDF in an application, 
such as Preview, that doesn’t know about digital signatures, you’ll 
simply see an ordinary PDF. 

• A certificate that can be used to verify your identity is expensive 
and awkward to obtain (unless you work for a large corporation or 
government entity that can supply its own). You can easily create 
your own “self-signed” certificate for free, but since no trusted third 
party has validated its authenticity, this is essentially no more 
secure than using a simple image of your signature. The recipient 
can verify only that the document hasn’t been tampered with, but 
not that you are who you say you are. (You can also obtain a free 
certificate that can at least confirm that your email address is the 
one used to request the certificate, but if you want anything fancier 
than that, you have to pay.) 

Certifiable: If you have a digital certificate suitable for signing 
email messages, as I discuss in Take Control of Apple Mail in Snow 
Leopard, you can use that same certificate to sign PDFs, too. 
Acrobat Pro can access these certificates in your keychain directly; 
to use them in PDF Studio Pro, you must first use Keychain Access 
to export the certificate as a .p12 file. 

For all these reasons, and because the details of dealing with cer-
tificates, validating signatures, and managing all the associated 
software infrastructure gets rather messy, I don’t include complete 
instructions here. (If there’s sufficient public interest, I’ll consider 
adding it to a future edition of this ebook.) 

http://www.takecontrolbooks.com/snow-leopard-apple-mail?pt=INTERNAL
http://www.takecontrolbooks.com/snow-leopard-apple-mail?pt=INTERNAL
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I can, however, direct you to two Macworld articles by Pariah S. Burke 
that cover portions of the process and will at least get you started: 

• “Create a digital ID with Adobe Acrobat” explains how to create 
a (self-signed) digital ID in Acrobat Pro that you can use to sign 
documents, although it doesn’t cover the process of obtaining an 
externally validated certificate (http://www.macworld.com/ 
article/142184/). 

• “Sign electronic documents with your own handwritten signature” 
shows you how to add a scanned image of your signature to a digital 
ID and use that to digitally sign a PDF (http://www.macworld.com/ 
article/142183/). 

 

http://www.macworld.com/article/142184/
http://www.macworld.com/article/142184/
http://www.macworld.com/article/142183/
http://www.macworld.com/article/142183/
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Fax without Paper 
 
You may think of fax as an outmoded technology that was long ago 
supplanted by email, but countless people still send and receive 
faxes every day. In certain environments—notably medical and legal 
practices—it’s widely considered more reliable and more secure 
than email. If you can’t remember the last time you had to deal with 
faxing documents, feel free to skip this chapter. But if you do find a 
need to send or receive documents by fax, even if only occasionally, 
this final chapter explains how to do so without owning a fax 
machine or generating any paper. 

Receive Incoming Faxes 
I’m not shocked that people still send and receive faxes, but I am a bit 
baffled as to why anyone would want a fax machine, as such, in this 
day and age. They’re bulky and require special consumables (beyond 
what you already buy for your printer). Although a fax machine can 
sometimes share a landline with a telephone, doing so makes it more 
awkward for both the fax sender and the receiver—and if you give it a 
separate line, then that’s an extra monthly expense. Who needs all that 
bother? 

Since you’re a Mac user, you have (at least) two excellent ways to 
receive faxes without having an extra box on your desk, and without 
generating extra paper. I’ll tell you about my favorite method first—the 
fax-to-email gateway—and then say a few words about using a modem. 

Note: I’m deliberately omitting multi-function devices (combi-
nation printer, scanner, and fax machine) from this discussion, 
because most of the arguments against using a stand-alone 
machine for receiving faxes apply equally to them, too. 

Use a Fax-to-Email Gateway 
A fax-to-email gateway works like this. You sign up with a provider 
and receive a private fax number. (Usually, you get to choose the area 
code—and sometimes the exchange too.) When a fax machine dials 
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that number, a computer answers, receives the incoming fax, and saves 
the image as a digital file (perhaps a PDF or a multi-page TIFF). Then 
it sends you the file as an email attachment—or, in some cases, merely 
sends you an email notification and lets you download the image itself 
using a Web browser or desktop application. 

One little gotcha: The only fax-to-email gateway I’m aware of that 
lets you keep your existing fax number is eFax (though it’s possible 
that some others have a similar capability). If lots of people already 
have your current number, using a service that requires you to switch 
to a different number may involve some inconvenience. 

As far as the sender is concerned, the experience is identical to sending 
a fax to an ordinary fax machine—they’ll never know that’s not what 
they did. But from your point of view, receiving a fax is just like getting 
an email message. But there’s a bonus: you can perform OCR on the 
incoming fax, just as you can on any scanned document (if the fax 
service provider doesn’t already do this for you)—and then archive it 
along with all your other searchable PDFs. 

Oodles of companies offer services like this, and pricing plans vary—
you may pay a monthly fee, a per-fax or per-page fee, or a combination 
of these. But the prices are invariably less than what you’d pay for an 
extra phone line plus paper, toner, maintenance, and electricity for a 
stand-alone fax machine. Here are but a few examples: 

• eFax (http://home.efax.com/) 

• jConnect (http://www.j2.com/) 

• MaxEmail (http://www.maxemail.com/) 

• MyFax (http://www.myfax.com/) 

• Nextiva (http://www.nextivafax.com/) 

I have no particular recommendations—my sense is that these services 
are more alike than different—but I’ll just mention that I’ve been a 
satisfied jConnect customer myself for years. 

All these companies also let you send outgoing faxes without any extra 
equipment—I discuss that topic in just a moment. 

http://home.efax.com/
http://www.j2.com/
http://www.maxemail.com/
http://www.myfax.com/
http://www.nextivafax.com/
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Use a Modem for Incoming Faxes 
A fax machine essentially consists of a modem, a simple computer, and 
a printer. So anyone with a modem attached to their computer and the 
right software can replicate the functionality of a fax machine without 
a separate box sitting on their desk. 

I remember the time—not so long ago—when all Macs had built-in 
modems. As broadband Internet connections became more common 
than dial-up access, most of those modems went unused, and in 2005 
Apple phased them out and began selling an external USB modem for 
those people who still needed them. But even the Apple USB Modem 
was discontinued in 2009. So Mac users who want modems have to 
look for models made by other manufacturers—or hope to chance on a 
used Apple USB modem on eBay. 

If you have, or can locate, a compatible modem, then you can receive 
faxes on your Mac. Like a physical fax machine, your Mac-based fax 
will require a phone line. On the plus side, it will give you the capabil-
ity of receiving faxes without having to print them out—and, as with 
fax-to-email gateways, you can perform OCR on the resulting files. 

To be blunt, I’d like to discourage you from doing this—I think it’s a 
cumbersome solution, and one without much of a future. But if you 
must use your Mac to receive incoming faxes, connect your modem 
and then do the following: 

1. Open the Print & Fax pane of System Preferences. 

2. Click the plus  button. 

3. In the Add Printer window, click Fax in the toolbar, select your 
modem, and click Add. The window closes. 

4. Back in the Print & Fax pane, select your virtual fax machine. Enter 
the phone number for the line to which the modem is connected. 

5. Click Receive Options. Then select Receive Faxes on This Computer 
and set the other options—such as how many times the phone 
should ring before answering and where to save incoming faxes—as 
you prefer. Click OK, and then close System Preferences. 

That’s it—your Mac is now a fax machine. (But read on for information 
about using it to send faxes.) 
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Send Outgoing Faxes 
Just as you can use either a gateway or a modem to receive faxes, 
you can use the same two techniques to send outgoing faxes. The 
process isn’t exactly analogous, in that you’re generally starting with 
a computer-generated document, but it’s still simple. 

Use an Email-to-Fax Gateway 
As I mentioned earlier, every fax-to-email gateway also works in the 
other direction—it lets you send faxes from your computer, although 
the exact procedure may or may not involve email. For example: 

• Email: Send email to a special address, and the text of your 
message (and/or an attached document) is converted to a fax. In 
some cases, you include the fax number itself in the email address. 
(For example, send a message to 15035551212@j2send.com and, 
because jConnect recognizes the From address associated with 
your account, it knows you’re allowed to send faxes; the part of 
the address before the @ sign is translated into the fax number.) 
In other cases, you’re expected to put the fax number in the subject 
or the first line of the message. 

Gotcha covered: For faxes that need a cover sheet, there’s 
usually some mechanism to create one—for instance, the text 
of the email message may be turned into a cover sheet, while the 
attachment is used for the remaining pages. 

• Web: Log in to your account in a Web browser, compose or upload 
a document, enter the recipient’s fax number, and click Send. 

• Desktop applications: Some services offer Mac applications 
that let you drag in (or compose) documents that serve as the fax’s 
content, design cover sheets, and connect to Address Book for fax 
numbers. 

• Print-to-fax: Desktop software such as jConnect’s j2 Messenger, 
can add features to standard Print dialogs, so that you can compose 
a document in nearly any application, choose File > Print, and then 
select the fax gateway and an associated fax number, instead of a 
printer, as the destination for your document. 
https://www.j2.com/jconnect/twa/page/downloadMac 

https://www.j2.com/jconnect/twa/page/downloadMac
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And, many services offer some combination of these approaches. 

In general, you can use any common document type for outbound 
faxes—for example, Word (.doc) or PDF. And, if you need to fax a 
document that you have only in paper form, no problem: scan it and 
then send the resulting file. I say more about occasions for doing this 
sort of thing in Sign Documents without Paper, earlier in this ebook. 

Send Outgoing Faxes Using Mac OS X 
A couple of pages back, in Use a Modem for Incoming Faxes, I 
explained how to set up Mac OS X to use an external modem to receive 
faxes. Once you’ve followed those steps, you’re also set up to send 
outgoing faxes. Again, I advise against doing this if you can possibly 
use an email-to-fax gateway instead. But if you want to send a fax 
through your modem, follow these steps: 

1. Compose your fax in any application that can print—Word, 
TextEdit, Mail, or whatever. 

2. Choose File > Print. But instead of clicking Print immediately, 
choose your virtual fax machine from the Printer pop-up menu in 
the Print dialog. 

3. In the To field, enter the recipient’s fax number; or, if that number 
is already in Address Book, click the plus  button, select the 
number, and click To. Repeat as necessary to add more recipients; 
close the Addresses window when you’re done adding recipients. 

4. If you need to enter a number or code before the number—say, to 
disable call waiting temporarily—enter that in the Dialing Prefix 
field. 

5. To add a cover page, check the Use Cover Page checkbox and enter 
the text you want to appear in the Subject and Message fields. 

6. Click Fax. 

Mac OS X “prints” your document to the recipient’s fax machine. 
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About This Book 
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com.  

Ebook Extras 
You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB and 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top of 
the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

About the Author 
Joe Kissell is Senior Editor of TidBITS and the 
author of numerous print and electronic books 
about Macintosh software, including Take Control 
of Mac OS X Backups and Take Control of Run-
ning Windows on a Mac. He is also a Senior 
Contributor to Macworld, was the winner of a 
2009 Neal award for Best How-to Article, and has 
appeared on the MacTech 25 list since 2007. Joe has worked in the Mac 
software industry since the early 1990s, including positions managing 
software development for Nisus Software and Kensington Technology 
Group. 

In his increasingly imaginary spare time, Joe likes to travel, cook, walk, 
and practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke, 

mailto:tc-comments@tidbits.com
http://www.takecontrolbooks.com/checkforupdates?mw=offiziersfisch&bt=0113&bv=1.0
http://www.takecontrolbooks.com/device-advice
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/windows-on-mac?pt=INTERNAL
http://www.takecontrolbooks.com/windows-on-mac?pt=INTERNAL
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their son, Soren, and their cat, Zora. To contact Joe about this book, 
send him email at jwk@me.com and include Take Control of Your 
Paperless Office in the subject so his spam filters won’t intercept it. 

Shameless Plug 
Although I write about computers as my day job, I have a great many 
other interests, which I write about on several Web sites, including 
Interesting Thing of the Day and my personal blog. You can find links 
to all my sites, a complete list of my publications, and more personal 
details about me at JoeKissell.com. 

About the Publisher 
Publishers Adam and Tonya Engst have been 
creating Apple-related content since they 
started the online newsletter TidBITS, in 1990. 
In TidBITS, you can find the Apple news, plus 
read reviews, opinions, and more 
(http://www.tidbits.com/). 

Adam and Tonya are known in the Apple world 
as writers, editors, and speakers. They are also 
parents to Tristan, who thinks ebooks about 
clipper ships and castles would be cool. 
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